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PART 1: ON1 RESIZE 2022 OVERVIEW

ON1 Resize 2022 is a professional-quality resizing tool that also incorporates a complete photo organizer. 
Resize’s primary features include:

• ON1 Resize: Resize gives you the highest quality photo enlargements of any resizing tool 
on the market. Using the patented, industry-standard Genuine Fractals algorithms, you can 
enlarge photos without the loss of sharpness or detail.

• Browse: Resize 2022 includes the core Browse module from ON1 Photo RAW 2022, giving 
you a lightning-fast browser and organizer. Simply point it to any folder of photos to preview, 
sort, tag and change metadata instantly.

• Batch Processing: The Export feature in Resize makes it easy to export a single photo or 
hundreds of them, using Resize’s core technology. Not only can you control the size, but the 
file type, naming, location, and so on. You can even apply gallery wrap or watermarks on the 
fly.

• Raw Processing: Resize 2022 features the raw processing engine from ON1 Photo RAW. 
When you browse, preview and resize raw photos, this powerful engine gives you fast, true- 
to-life color and detail.

• Printing: You can print from inside ON1 Resize 2022. Control the paper size, margins and 
printer profiles for the ultimate print.

If you have an existing image editing and workflow app such as Adobe’s Photoshop, Lightroom Classic or 
Photoshop Elements, or Capture One, ON1 Resize 2022 can also work as a plugin to these apps, giving you 
direct access to all of Resize’s image-scaling power.



ON1 Resize 2022 User Guide Part 1: Overview 2

Getting Help
You can find an extensive collection of 
video tutorials and help documents in 
the Help section of the ON1 website 
(on1help.zendesk.com). This is the 
quickest way to dig into Resize. There, 
you can search our Knowledge Base for 
frequently asked questions, and more. 

Inside ON1 Resize, you can use the 
Learning Hub to directly display videos 
for getting started with the app, search 
the ON1 online help system—including 
with and online chat assistant—and the 
ON1 Shop, where you can purchase 
add-ons and courses for Resize.

The Learning Hub is accessible via the 
Help menu or from the Help icon at the 
bottom of the left bumper panel. 

System Requirements
MINIMUM RECOMMENDED

OPERATING SYSTEM macOS 10.14, 10.15, 11; Windows 10
current maintenance releases, 64-bit 
only

macOS 10.15, 11; Windows 10 
current maintenance releases, 64-bit 
only

PROCESSOR Intel Core i5, Xeon or better processor; 
Apple Silicon processor

Intel Core i7, Xeon or better processor; 
or Apple Silicon

RAM 8 GB 16 GB or more

HARD DRIVE 1.5 GB for installation 1.5 GB for installation 
SSD drive

DISPLAY OpenGL 3.3 compatible video card 
with 512 MB VRAM, 1280x800 
resolution (at 100% scale factor)

OpenGL 4.2 compatible video card with 
2GB+ of dedicated VRAM, 1920x1080 
resolution (at 100% scale factor)

OPTIONAL APPLICATION 
INTEGRATION

Photoshop CS6 and above; Photoshop 
Elements 14 and above; Photoshop 
Lightroom Classic 6 and above
Capture One 10 and above

Photoshop CC 2021 
Photoshop Elements 2020
Photoshop Lightroom Classic CC 2021
Capture One 10 and above

INTERNET A high-speed internet connection and active account for activation, auto-update 
checking, content downloads, and tutorials.

SUPPORTED OPTIONS Supports pressure-sensitive tablets for controlling brush size and/or opacity. 
Supports ICC/ICM profiles for camera input, display, soft-proofing, and printing. 
Hardware display calibration tool is recommended.

LANGUAGES SUPPORTED English, German, Spanish, French, Japanese, Korean, Simplified Chinese, Russian, 
Portuguese, Italian, Dutch

The Learning Hub is available directly within ON1 Resize 2022, and includes links to videos 
(which can be played directly in the Hub), ON1’s online help system, and the ON1 store.

https://on1help.zendesk.com
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Installation
To install ON1 Resize 2022, double-click the installer icon and allow the installer to guide you. Before 
installing or updating, close any supported host applications (Adobe Photoshop, Photoshop Elements, 
Lightroom or Capture One), as well as any previous versions of ON1 products.

MACOS

The application is installed in the ON1 Resize 2022 folder in the Applications folder. 

All plugin files for supported host applications found during the installation process will be installed 
automatically; a summary of installed plugins will be displayed at the end of installation. If a previous 
version of Resize is found, it will be maintained or replaced based on your preference during installation.

Support files are installed into /Library/Application Support/ and ~/Library/Application Support/ folders.

WINDOWS

The application is installed in the ON1 Resize 2022 folder in the \Program Files\ON1\ directory.

All plugin files for supported host applications found during the installation process will be installed 
automatically; a summary of installed plugins will be displayed at the end of installation.

If a previous version of ON1’s Resize is found, it will be maintained or replaced based on your preference 
during installation.

Support files are installed into \ProgramData\ON1\.

UPGRADING FROM PREVIOUS VERSIONS

If you have earlier versions of ON1 Resize on your computer, the installation process will move over any 
cataloged folders, albums, and metadata presets. 

BACKING UP YOUR RESIZE CONFIGURATION

ON1 Resize 2022 includes a back-up and restore function for most of the app’s settings, presets, extras and 
much more (your photos are not backed up, however). To learn more about this feature, see page 92.

Launching ON1 Resize 2022
To launch ON1 Resize 2022 from an external application—Adobe Photoshop, Photoshop Elements,  
Lightroom Classic or Capture One—see “Using Resize 2022 as a Plugin” on page 6 for complete 
instructions. To launch Resize 2022 as a standalone app, follow these steps:

MACOS

Open the Finder, and navigate to the Applications folder. Find the ON1 Resize 2022 folder and double-click 
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on the Resize 2022 icon. You can also add ON1 Resize 2022 to your dock (or Launchpad) for easy access by 
clicking and holding the icon in the dock and selecting the Keep In Dock option. 

WINDOWS 10

Open the Start screen by pressing the Window key, and select ON1 Resize 2022. If you selected the “Add 
Icon to Desktop” option during installation you can also access Resize from there.

Licensing and Registration
When you first launch ON1 Resize 2022, the upper left side of the main window will have two buttons, Buy 
Now and Sign-In. 

IF YOU HAVE PURCHASED ON1 RESIZE 2022:

Click on the “Sign-in” button and fill in your ON1 
account information (email and password) to register 
the app with us. (You should have set up an account 
when you purchased the software.) If the computer 
you are signing in with does not have access to the 
internet, you can manually register your software by 
clicking on the “No Internet connection” link in the 
license dialog.

Your license lets you install ON1 Resize 2022 on two 
computers. When you enter your ON1 account info, 
Resize 2022 communicates with the ON1 activation 
server and registers your software for that computer.

If you wish to move your copy of Resize from one registered computer to a new one, and you are not going 
to be using the older machine, it is best to sign out of the old computer first. Open Resize and select Sign 
Out from the Help menu. This will deactivate Resize 2022 on the current machine, and you can install and 
sign in on another machine.

You can log into your ON1 user account area (www.on1.com/login/) at any time to download the software, 
see the number of computers you have registered, and make basic changes to your account information, 
including your email address, password, and notifications.

If you have issues related to installing or activating Resize, please contact ON1 customer support, which 
can be reached by clicking on the ON1 website’s Support tab (on1help.zendesk.com).

TRIAL VERSION

ON1 Resize 2022 can also operate as a fully featured trial version for 14 days from when you first launch it. 
This gives you time to evaluate the product and see if it fits your needs. Each time you launch Resize during 
the trial period, the Buy Now button will tell you how many days remain in the trial.

You can purchase ON1 Resize 2022 at any time by clicking on the Buy Now button. Once you do that, click 
the Sign-In button the next time you launch the product and enter your ON1 account information. If your 

When you first launch ON1 Resize, sign in with your ON1 User ID 
(which you set up when you purchased the software) If you downloaded 
the app to try out, you can see how many days are left in your free trial.

https://www.on1.com/login/
https://on1help.zendesk.com


ON1 Resize 2022 User Guide Part 1: Overview 5

trial period has ended, Resize will present you with an activation window when you launch the app. There, 
you can enter your ON1 account info to activate the app.

PRODUCT IMPROVEMENT PROGRAM

We believe that the best products are made by listening to our customers. We use many methods to 
gather your ideas and feedback including: emails, surveys, direct conversations, market analysis and the 
Product Improvement Program. The Product Improvement Program is built into our software and gathers 
information about how our software is used. It is the most accurate way for us learn what features are 
important to you and how our products fit into your workflow.

Enrollment in the program is voluntary. When you participate, we collect basic information about how you 
use our programs and basic information about your computer. This information helps us learn what features 
are important to you and how we can make our software easier to use. No personal information is collected 
and you will not be contacted.

You can choose to participate in the Product Improvement Program the first time you launch ON1 Resize 
2022. You can change your participation later, just click the Help menu, then Help Improve ON1 Products.

To learn more about the Product Improvement Program, go to the Support area of the ON1.com website.

Uninstalling ON1 Resize 2022
To uninstall ON1 Resize 2022, first deactivate your product: open ON1 Resize 2022 and select Sign Out… 
from the Help menu. (This will allow you to transfer your license to another computer.)

MACOS

1. Go to the Applications/ON1 Resize 2022/Documentation folder.

2. Double-click on the Remove ON1 Resize 2022 application.

WINDOWS

1. Go to Control Panels.

2. Under Programs select Uninstall a program.

3. In the list that comes up select ON1 Resize 2022 and then click on the Uninstall button.

Working with Files
ON1 Resize 2022 can view and open the following file types, in RGB color, at either 8/16 bits per pixel:

• Raw files from most major camera manufacturers (file extension varies by manufacturer)

• Digital Negative (DNG)

• Photoshop (PSD)

• Photoshop Large Document (PSB)
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• Tagged Image File Format (TIFF)

• Joint Photographic Experts Group (JPEG)

• Portable Network Graphic (PNG)

• High Efficiency Image Format (HEIC) 

When you wish to export or share images, Resize can save files in PSD, PSB, TIFF, JPEG, and PNG format.

NOTE: ON1 Resize 2022 can view and catalog most standard video formats 
inside Browse. While you cannot play or edit video from within Resize, you can 
perform file management tasks and edit metadata. Double-clicking on a video 
file in Resize will launch the default video player for your computer.

ON1 Resize 2022 Modules
ON1 Resize 2022 has two modules: Browse and Resize, which are accessible via the module 
selector on the left side of the screen. Each module focuses on one task, giving you access to 
just what you need to get that task done. Browse handles file-management operations, and 
Resize is used to enlarge images, largely for printing to large-format printers.

When used as a standalone application, Browse is the default module when you launch the 
app. It is used to navigate through your drives and cloud services to find images, as well as to 
import photos. When you’re using ON1 Resize 2022 as a plugin, the Browse module is disabled, 
although the printing, export and sharing options are still available. As a plugin, the Resize 
module is the only visible module.

THE MODULE SELECTOR

The Module Selector is on the right side of the screen, visible at all times. At the top of the 
selector is the Browse icon, while the Resize icon is at the bottom of the selector, along with 
icons for printing, sharing or exporting an image or group. (For more on this, see “Export, Printing 
and Sharing” on page 59.)

To open a photo in Resize, select it in Browse and click the Resize icon. When you are working in 
either Browse or Resize, clicking on the Print, Share or Export icons will open that option. 

Using Resize 2022 as a Plugin
In addition to using ON1 Resize as a standalone app, with full file management capabilities in the Browse 
module, you can easily export files to Resize from Adobe Photoshop, Photoshop Elements, Lightroom 
Classic and Capture One.
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USING RESIZE WITH ADOBE® PHOTOSHOP®

ON1 Resize 2022 is accessible from within Photoshop via the File > Automate menu. Selecting that item will 
open the image in Resize. When you are finished resizing your image, clicking the Done button inside Resize 
will apply the transformation and save it back to Photoshop at the new dimensions. (Clicking Cancel inside 
Resize will close the file without making changes.) 

USING RESIZE WITH PHOTOSHOP® ELEMENTS

ON1 Resize 2022 is accessible from within Photoshop Elements via the File > Automate menu. Selecting 
that item will open the image in Resize. When you are finished resizing your image, clicking the Done 
button inside Resize will apply the transformation and save it back to Photoshop at the new dimensions. 
(Clicking Cancel inside Resize will close the file without making changes.)

USING RESIZE WITH LIGHTROOM® CLASSIC

ON1 Resize 2022 can be accessed from within Lightroom Classic CC, providing an integrated, round-trip 
workflow of your images. There are two primary ways to use Resize with Lightroom, via the Plug-in Extras 
command in the File menu and the Edit In command in the Photo menu. Both generally work the same way, 
the primary difference being where you choose the file format of the photo being opened in Resize, and 
that you can batch process multiple photos when using the Plug-in Extras menu item. Using Plug-in Extras 
opens the file using the format chosen in Resize’s Plugins Preferences pane, while Edit In uses Lightroom’s 
export facility to send a single image to Resize. 

If you use Resize as a plugin from Lightroom, we recommend using the Photoshop format (.PSD) as the 
exchange file format for maximum compatibility. If your saved file will be larger than 2GB, or more than 
30,000 pixels on a side, your image will automatically be saved in the .PSB (or Large Document) format. 
This is a newer version of the PSD format designed for larger file sizes, and is fully compatible with Resize.

Using ‘Plug-in Extras’

To edit an image in Resize, select the image in Lightroom, go the File menu and select the Plugin Extras 
submenu, and choose ON1 Resize 2022. 

When you access ON1 Resize 2022 through the Plugin Extras menu there are file-handling options that 
are controlled in the Plugins tab of the Resize Preferences window. These should be configured in advance, 
based on your desired workflow. Once these are set, all images sent to Resize 2022 via the Plugin Extras 
submenu will use these characteristics:

• File Format: Determines what type of file will be created. The default is PSD. You can also 
select JPG or TIFF formats.

You can access Resize from Lightroom Classic from either of two submenus, File > Plug-in Extras (above, left), or Photo > Edit In (above, right). There 
are small differences between the options, but both will get you to Resize quickly. Which one you choose is open largely to personal preference.
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• Color Space: The color space drop-down menu determines what RGB working color space is 
used; Adobe RGB 1998, sRGB or 
ProPhoto RGB.

• Bit Depth: The bit-depth drop-down 
menu determines the bit depth (8 or 
16 bits per pixel).

• Resolution: Determines the resolution 
of the file.

• Stack with Original: When enabled, 
the new image is stacked with 
the original image upon return to 
Lightroom from Resize.

• Use Original for Single PSDs: When 
enabled, if you select a single image in 
PSD format, the original file will be 
edited, rather making a copy.

• Ask Every Time: When checked, Lightroom will 
present these export copy options whenever you 
chose an item from the Plug-In Extras submenu. 
Turning this option off will bypass the file-export 
window inside Lightroom, using the options set in 
Plug-In Preferences window. 

If you have the Ask Every Time option checked, you’ll be 
presented with the Export Options window inside Lightroom 
whenever you send an image to Resize (shown on the right). 
The Export Options window lets you adjust the file format 
characteristics as needed, and is designed for users with 
variable workflow needs. If you find that you use the same 
options every time, then you can set those parameters in 
Resize’ Preferences window by unchecking the Ask Every 
Time option.

Batch processing multiple files with Plug-In Extras

You can batch process multiple images for resizing via Plug-In Extras. Select the images you wish to work 
with in Lightroom’s Library module and choose Resize from the Plug-In Extras submenu. The Export 
Options window will open with two batch options:

• Pause on First Photo: Use this option when you wish 
to apply the exact same editing operations to a group of 
photos. This option will open the first selected image 
inside Resize. There, perform any editing option you 
wish, including applying presets, any cropping, and 
other adjustments in Resize. When you have finished 
with your edits, click Done. Resize will then apply all 
of the edits (including the exact crop position) to each 
image in the group, and return you to Lightroom.

When sending a file from Lightroom to Resize via Lightroom‘s Plug-In Extras 
menu, the edited file will be created according to your settings in the Plug-Ins 
section of Resize’s Preferences window.

The Batch Options window comes up when you wish to 
send a group of photos from Lightroom to Resize. (If you 
have the Ask Every Time option set in Resize’s 
Preferences, Batch Options will be displayed as a 
section in the Export Options window..)
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• Pause on All Photos: This option lets you sequentially edit the images in the batch. Resize 
will open each image in the destination tab, where you can edit it as desired. When you are 
finished editing with one photo, click Done, and Resize will save that photo and open the 
next one, with the previous photo’s Resize settings applied. (You can reset any or all of those 
settings as desired.) When you have finished editing the last photo in the group, clicking 
Done will save the image, close Resize and return you to Lightroom.

Using ‘Edit In’

When you use the Photo > Edit In submenu, Lightroom will ask 
you each time for the resultant format how you wish to edit the 
selected image. You have three choices: 

• Edit a Copy with Lightroom Adjustments, which 
makes a copy of the file that includes any edits you 
have made in the photo;

• Edit a Copy, which copies the original photo without 
any changes made in Lightroom; or

• Edit Original, which sends the original version of the 
photo to Resize, unless the photo is a raw file, in which 
case the option will be unavailable.

In the Copy File Options, you set  the file type (TIFF, Photoshop 
PSD or JPEG), the color space and bit depth for the resultant file.

When you have set your options and click the Edit button, 
Lightroom will create a new file (or send the original) and launch 
Resize. When you’re finished, click the Done button to save your changes, close Resize, and return the file 
to Lightroom. To return to Lightroom without saving your edits, click Cancel.  

USING RESIZE WITH CAPTURE ONE

When you edit an image sent from Capture One to ON1 
Resize, Capture One creates a variant of the current photo. To 
resize an image inside Capture One, follow these steps:

1. Open the image you want to work on in Capture 
One.

2. From the Image menu, select Image > Edit With > 
ON1 Resize 2022.

3. Choose the file characteristics you wish to use 
in Resize—File Type, Bit Depth, ICC Profile, and 
Resolution—and click the Edit Variants button to launch Resize.

When you’re finished editing your photo, click the Done button in Resize. Your resized variant will be visible 
in the current collection.
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Batch processing Files in Resize with Capture One

You can process multiple images for editing in Resize with Capture One. Select the images you wish to work 
with in Capture One and choose Image > Edit With > ON1 Resize 2022. The Export Variant window will 
open with an additional tab, ON1 Batch, which contains a pop-up with two options:

• Pause on First Photo: Use this option 
when you wish to apply the exact same 
editing operations to a group of photos. 
This option will open the first selected 
image inside Resize. There, perform any 
editing option you wish, including adding 
filters, applying presets, retouching 
operations, cropping, masks, local 
adjustments and more. When you have 
finished with your edits, click Done. Resize 
will then apply all of those edits to each 
image in the group, and return you to 
Capture One.

• Pause on All Photos: This option lets you sequentially edit the images in the batch. Resize 
will open each image in the destination tab, where you can edit it as desired. When you are 
finished editing with one photo, click Done, and Resize will save that photo and open the 
next one, with the previous photo’s Resize settings applied. (You can reset any or all of those 
settings as desired.) When you have finished editing the last photo in the group, clicking 
Done will save the image, close Resize and return you to Capture One.

Before sending multiple images to Resize from Capture One, you can also click on the Basic, Adjustments 
and Metadata tabs to change those options. Once you have all the options chosen, click the Edit Variants 
button and Resize will process that group based on your batch settings.

Extras
ON1 Resize 2022 supports two additional file types 
that can be used within the app. These files are 
called Extras, and the file types include:

• Resize Presets, specific crops for a wide 
range of paper and printer types for use 
within the Resize module (see page 55).

• Watermarks, image files (transparent 
PNGs) that can be used with the 
Watermark pane of Resize’s Export (page 
65) and Print (page 74) features. 

You can import, export and manage presets and 
watermark files via the Extras Manager in either the 
Browse or Resize modules.
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To import extras, choose Manage Extras from the File menu, then click on the Import button in the footer 
of the left column. A dialog box will appear where you can select the files to import. If you want to import 
an entire folder, open the folder, select the first file, then shift-click on the last file. Click Import when your 
selection is complete. Then, select a category for your extras to live, which is where you will be able to find 
it inside Resize. You can select from an existing category or create a new one.

ORGANIZING PRESETS

When you are in the Extras Manager, you’ll see ‘+’ and ‘-’ buttons, which let you add or delete categories to 
the list of your presets. You can also add subfolders to any of the categories, which can help organize and 
manage large collections of presets. You can use drag-and-drop to move existing categories into another, 
or you can add a category subfolder to an existing category by clicking on the category and then clicking 
on the ‘+’ button in the Extras Manager window. (When you are importing presets, Resize gives you the 
opportunity to add presets to any category folder or subfolder.)

In addition to the Import option, the Presets section of the Extras Manager will also let you export presets, 
for sharing with other users, or to save seldom used presets for archiving purposes. To export a complete 
category, click on the category in the list on the left side of the window and click on the Export button. 
This will export a folder that contains a single .ONpreset file, which includes all of the presets from that 
category. If you would like to export a single preset, click on the preset from the list on the right side of the 
window and click Export.

HOW TO DELETE EXTRAS

You can remove imported extras using the Extras Manager. Follow these steps:

1. Open the Extras Manager in any module (File > Manage Extras).

2. Click on the extras type that contains the content you wish to remove. This will display 
categories within that type.

3. To delete an entire category, select in the left column and click on the Delete button in the 
footer of the left column.

4. To delete individual extras, select them in the right column and click on the Delete (‘—’ in the 
Presets tab) button in the footer of the right column.

Deleting extras is permanent and cannot be undone.
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Customizing Resize’s Keyboard Shortcuts
You can customize ON1 Resize 2022’s hotkeys via 
the Keyboard Shortcuts window. This window lets 
you view and change the shortcuts for any tool, tool 
option, module, or menu item inside Resize. You 
can assign shortcuts to items that don’t yet have a 
shortcut, build multiple sets of shortcuts as preset 
styles, and create a summary of your shortcuts that 
can be viewed in any web browser.

To view or change Resize’s hotkeys, choose 
Keyboard Shortcuts from the Edit menu. By default, 
Resize’s shortcuts will be displayed, organized 
hierarchically by the following groups: 

• Modules, commands for switching 
between Browse and Local Adjustments.

• Tools, for the tools available in Resize. 
(Only the Crop and Zoom tools are 
applicable to Resize from this list.) 

• Tool Options, which is not used with 
Resize.

• Menu, which includes all of Resize’s menu 
items. 

You open each group by clicking on the triangle to the left of the group name, or you can use the search 
field at the top of the Keyboard Shortcuts window to search for a command in any of the groups. 

Each command that has an assigned key will display that key in the Shortcut column. The Shortcut field 
will be empty for any command that doesn’t have an assigned key, and any field with a grayed-out shortcut 
means that you cannot modify that command’s keys.

NOTE: Some keyboard shortcuts cannot be changed. These include menu 
commands used by the operating system (Cut, Copy, Paste), and the Browse 
module shortcut (G). Also, you can’t use the Escape, Return/Enter, or Delete 
keys as a shortcut.

MODIFYING HOTKEYS

The Default preset style’s hotkeys cannot be modified, but you can create your own set of shortcuts by 
double-clicking on any command you wish to add or change. You’ll be asked if you want to create a new 
preset. Clicking Yes will let you name the new preset style, and Resize will make a duplicate of the Default 
set.
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At this point, you can change any existing hotkeys —or add your own shortcuts for commands that don’t 
have them —by double-clicking in the Shortcut field for that command. The field will be highlighted, and you 
can press the key or key combination you wish 
to use. If that key is used by another command, a 
dialog will come up, informing you of that, and 
giving you the option of either keeping the 
existing hotkey/command combination, or 
changing it to the new command.

When you change a default shortcut to a new 
key combination—even for commands and 
options that didn’t initially have a shortcut—a 
Reset arrow will appear to the right of the 
Shortcut field. Clicking the icon will reset the 
command to its original state, from the Default 
preset style.

To delete a shortcut, double-click in the Shortcut 
field and press the Delete key. 

The Summarize button at the top of the 
Keyboard Shortcuts window will create an 
HTML table of the current set of hotkeys. You’ll be asked where to save the file, and double-clicking on it 
will open that table in your default web browser, where you can view or print the list. 

You can return to the original Resize shortcuts by clicking on the pop-up menu at the top of the Keyboard 
Shortcuts window, and choosing Default from the list of preset styles. That menu can also be used to 
create a new preset or to delete an existing one that you created. The Default preset cannot be removed, 
however.

When you add or change a hotkey the first time, Resize will prompt you to 
create a new preset style, which makes a duplicate of the Default preset. You 
can switch between preset styles—including back to Resize’s Default set—by 
using the pop-up menu at the top of the Keyboard Shortcuts window.

If you try to add a shortcut key combination that is already in use, Resize will 
let you know, and give you the option of keeping (Cancel) or removing (OK) the 
other command/shortcut.



ON1 Resize 2022 User Guide Part 2: Organizing with Browse 14

PART 2: ORGANIZING WITH BROWSE
ON1 Resize 2022’s Browse module is a powerful and incredibly fast photo browser and manager. It gives 
you one place to find, view and manage your images, no matter where they are located.

Browse is an ideal environment for performing quick sorts and edits after a shoot: You can import, then 
view, your photos immediately without having to wait for a long cataloging or preview-creation process. 
You can rate, add keywords and flags, even remove photos, all from within Browse.

But Browse also has a sophisticated indexing system built in, designed to let you get access to your favorite 
folders of images in a jiffy; just add a folder to the My Catalogs pane, and it will index your photos in the 
background wherever they reside, giving you increased search capabilities and even faster access to your 
most important photos.

Some of Browse’s key features:

• Find your photos fast, wherever they are: local or network drives and cloud-based services.

• Add any metadata—from creator to keywords and GPS and much more—quickly to a photo 
or group of photos, and use metadata templates to apply often-used metadata information 
during the import process.

• Catalog important folders of photos, to get the fastest access to your most important photos 
across multiple sources, while still preserving your folder hierarchies and locations.

• View and cull photos from a shoot in the way that works best for you, in four different ways: 
Grid, Filmstrip, Detail and Compare views. In addition, use the Map view to see where you 
shot your photos, or add location information to photos without GPS metadata.

• Dual-display capability that lets you work more efficiently. See Grid view on one display, and 
Detail view on another, or use this mode to present photos on a TV or projector.

• Quickly find photos based on their creation date, or any combination of metadata 
information, including time of day, camera/lens type, file type and more.

• Create albums from a selection of photos, or use advanced searching methods to create 
‘virtual’ albums based on metadata.

• Copy, move, delete and rename files.

• Sort, flag, rate or color code your images.
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ON1 Browse Main Screen Overview
The Browse module has three main sections: the Browse/Presets panel on the left side of the screen, the 
Preview window in the center, and the Photo Info panel on the right side. The main components of Browse 
module include:

A. Shortcuts: This palette contains shortcuts to the Getting Started window, as well as your 
most common photo storage locations. (See page 30)

B. Preferences/Help icons: Accesses the ON1’s Help website and Resize’s Preferences window.

C. My Catalogs/Browse Panels: Switch between cataloged folders and local drives/cloud 
sources by clicking on the tabs.

D. Cataloged Folders/Browse Panes: Displays your cataloged folders (shown) or local disks and 
cloud sources, depending upon which tab has been selected.

E. Albums Pane: This pane lets you to create albums (or collections) of images. Albums can be 
grouped into subfolders for easy organization.

F. Dates Pane: Search for photos based on the capture date.

G. Advanced Search Pane: Search for photos in your library based on any metadata, and save 
your searches to find them later. (Formerly known as the Filters pane.)

H. Recent Pane: This keeps track of recently opened files and folders.

I. View Selector: (Icons from left) Open/close the Browse/Presets panel; toggle Dual Display 
Mode on and off; switch between Grid, Detail, Filmstrip, Compare and Map views.
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J. Preview: The window where you can view your images in thumbnail or detail view.

K. Thumbnail Size/Sort Options: The slider adjusts the thumbnail size, while the Sort By pop-up 
adjusts sort order based on standard selection criteria, such as file name, date captured and 
more. (You can also create your own custom sort order.)

L. Breadcrumbs: This shows the path of the selected image or folder in the Preview area, 
displaying the number of files and folders you are viewing.

M. Search Field: Lets you search in the current view for any available metadata based on the 
search string. (Uses the Advanced Search pane.)

N. Raw Preview Mode: Lets you set how you would like to view photos in Detail mode. Fast 
will use embedded previews from the photos, while Accurate will generate a color-balanced 
preview. 

O. Copy to My Catalogs: Clicking this button lets you add the currently selected photos to any 
of your existing cataloged folders.

P. Info Pane: This section will give you detailed metadata about your image when available. 
(Also displays Navigator and Histogram panes when viewing in Filmstrip, Detail and Compare 
modes.)

Q. Metadata Pane: This pane will show your metadata for the selected image.

R. EXIF/IPTC/Location Info: Displays additional detailed information about the selected file.

S. Keyword List: All keywords found in your image catalog.

T. Module Selector: Use this to switch between the Browse and Resize modules.

U. Export/Print/Share: Shortcuts for exporting, printing and sharing selected photos. The 
bottom icon will open and close the Info pane.

WORKFLOW BASICS IN BROWSE

When using ON1 Resize 2022 in standalone mode, you have a great deal of flexibility in how you wish to 
work with your photos. You can browse for existing photos in folders that are connected to your computer 
(including cloud services like Dropbox, Google Drive and Microsoft OneDrive). If you store your photo 
library in a specific location on an internal or external hard drive (or multiple drives), you can have Browse 
index those folders. This process ‘catalogs’ the photos, reading their metadata and building previews, 
letting you navigate and access your photo library much more quickly than if you were to simply look at a 
random folder of images. Cataloging a folder doesn’t move or change your photos; it just makes it easier for 
you to find and work with them inside Resize. (See page 28.)

Getting Started

The first time you launch Resize as a standalone app, Browse displays a Getting Started window, designed 
to help you get working quickly (shown on the following page). This window has three options:

• Resize a Single Photo: clicking this button will give you the MacOS or Windows file-selection 
dialog, where you can navigate to a specific photo. Once you’ve chosen an image, it will open 
directly within the Resize module.

• Browse a Folder: this button will open the file-selection dialog for your computer. There, you 
can navigate to a specific folder of photos. Clicking the Open button in that dialog will display 
that folder’s photos in the Browse Preview area.
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• Catalog Your Photos: clicking this button will let you choose a folder to be cataloged by 
Resize. This folder (and any subfolders of photos within it) will be added to the My Catalogs 
pane. (See “Cataloged Folders” on page 28 for specifics on creating cataloged folders.)

The Getting Started window can be accessed at any time by clicking the ‘+’ button in the Shortcuts section 
on the left side of the Browse window (see “Using Shortcuts” on page 30), or via the Help menu. 

Working in the Preview Area
The Preview window is the largest part of the Browse workspace. Here, you can view folders of images 
in either thumbnail or detail view, based on the folders, albums or filters you have chosen via the Browse 
panel. There are five main views in the Preview window:

• Grid, which displays a grid of thumbnails of your images. This view also displays folders, 
letting you go up and down a folder hierarchy quickly. Shortcut key: G

• Detail, which you get by double-clicking on a thumbnail. You can view this image in either ‘fit 
to window’ view, or can zoom in to see more detail. Shortcut key: E

• Filmstrip, which displays a strip of images from a folder or album at the bottom of the screen. 
The currently selected image displays in the preview area above the strip; use the arrow keys 
to move through the folder, or click on an image in the filmstrip to view it in the preview area. 
Shortcut key: F

• Compare, which lets you view a group of photos in separate panes inside the preview area. 
You can zoom in on one or all of the selection, and lock the panning so that, as you move 
around one photo, the others move with it. Using Compare, you can quickly find the best 
images in a sequence, whether it be for composition, sharpness, facial expressions or more. 
Shortcut key: C

• Map, which can be used to display locations for photos that have GPS-based location data, or 
to search for locations that can then be applied to a photo or group of photos. Shortcut key: M

You can change the viewing mode between the different views by clicking on the view selector at the 
bottom of the window, or by using the keyboard shortcuts listed above. 

The Getting Started window is designed to help you get working quickly with ON1 Resize 2022.
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ALTERNATIVE VIEW MODES

In all of the preview modes inside Browse, you have three options for viewing the contents of the current 
window:

• Browse’s default is a resizable, movable window.

• Full Screen Mode, which can be found in the Window menu, will expand the main window 
to fit the contents of the current display. The menu bar is hidden, but it can be viewed by 
moving the mouse cursor to the top of the screen. This mode can be toggled on and off by 
pressing Option-Control-F (Windows) or Command-Control-F (MacOS).

• Full Screen Preview, also found in the Window menu, will display the currently selected 
photo full-screen, without any of the other interface elements. You can use the arrow keys on 
the keyboard to This option is helpful when you wish to view a selection of photos as large as 
possible without any distractions. (This option is not available in the Resize module.)

Displaying slideshows

In addition to the options displayed above, you can create 
on-the-fly, full-screen slideshows to display groups of 
photos inside Browse. To use this feature, select a group 
of photos in the preview area, and choose Window > 
Quick Slideshow > Start Slideshow. The slideshow will 
loop until you stop, by pressing the Esc key.

The Quick Slideshow submenu has options for the amount 
of time between slides and whether to display a fade transitions between slides or have no transition at all. 

FAST PREVIEW MODE

Sometimes, when you get back to your computer after a shoot, you want to be able to go through a large 
number of photos quickly, looking for your best shots. ON1 Resize’s Fast Preview mode lets you do just 
that. Simply choose Fast from the RAW Previews pop-up at the bottom of the Browse window, and you can 
jump from photo to photo quickly with minimal lag between shots.

If you are more concerned about color accuracy than speedy previews, select Accurate from the RAW 
Previews pop-up. ON1 Resize will generate a full-resolution preview of your photo, using the photo’s 
embedded color profile. This will take a few seconds, depending upon the size of the raw file you’re 
working with, but you will get a better sense of the actual color in the photo.

Persistent Thumbnail Cache

When you go through a folder of photos, Browse caches thumbnails and preview images as well as 
extracted metadata. This will make it faster the second time a user browses a folder. It also stores user-
added or adjusted metadata such as ratings, labels, keywords, captions, rotation and GPS data, among 
others. 

You can adjust the size of the cache and change the storage location of the cache in the System tab in ON1 
Resize 2022’s Preferences window (page 91).
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FOCUS AND CLIPPING VIEWS

When you’re viewing photos with an eye toward selecting the best images in a group for editing, you 
generally want to look at issues with both exposure and sharpness. To help you with this, Resize offers two 
viewing aids that are available in Browse: Clipping and Focus Mask overlays. You can display these overlays 
in Detail, Filmstrip and Compare modes.

Clipping

Clipping occurs when the shadow and highlight 
tones in an image are suddenly cut off to 
completely white or black, rather than fading 
smoothly. (Large expanses of white pixels in a 
photo are often referred as ‘blown’ highlights, and 
can be quite distracting to a viewer.) One of the 
benefits of shooting in raw format is that, while 
many photos will have areas of pure white or black 
when originally viewed on-screen, there is still 
recoverable data in the raw image. The Clipping 
overlay can help determine how big a problem you 
might have with a photo, and how easy (or difficult) 
it will be to fix. 

To display the Clipping overlay temporarily, 
press the J key; to turn it on permanently as you 
move from photo to photo, choose View > Show 
Clipping, or press Alt (Windows) or Option (Mac) J on your keyboard.

The Clipping view overlay displays the areas that have either pure white or pure black in them. Those areas 
with a bright blue overlay indicate pure black pixels, while the areas with the bright red overlay indicate 
pure white pixels.

Clipping view is also available in the Resize module.

Focus Mask

It can often be difficult to view the sharpness in a photo 
without zooming in to 100% or more, and if you have a 
lot of photos from a shoot, it can be a bit tedious to check 
focus at that level. Luckily, Resize’s Focus Mask overlay can 
help winnow your shots down to the sharpest ones.

To turn on Focus Mask, choose View > Show Focus Mask, or 
press Shift-Alt/Option J. The sharpest areas in your image 
will be represented by a bright green overlay. As you move 
from photo to photo in a folder, you’ll be able to tell whether 
you have an acceptable level of sharpness where you need it 
by the strength of the overlay. The mask will continue to be 
displayed even as you zoom in on a photo.

Clipping view displays pure white pixels with a bright red overlay, and pure 
black pixels with a bright blue overlay.

The Focus Mask option displays areas of sharpness with a 
bright green overlay.
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GRID VIEW

Grid view displays thumbnails of folders and images you have selected using the Folder or Albums panes. 
There are many operations you can perform from inside Grid view, including:

• Use the breadcrumbs to navigate (the ‘<’ button goes up one folder).

• Select your image while in Grid view and open the photo in Resize.

• Adjust thumbnail size using the on-screen slider or use “-/+” keys on your keyboard.

• Check Show Sub-Folder Contents when you want to view the contents of all sub-folders (this 
only works when you are viewing cataloged folders).

Changing the thumbnail display options

You can change the display characteristics of each 
thumbnail cell in Grid view, via the Thumbnail 
View Options command, which is in Browse’s View 
menu (and available when you right-click on any 
thumbnail in the grid). The Thumbnail View Options 
window has two sections, one for choosing the 
appearance of each thumbnail, the other for the 
information labels associated with each thumbnail.

In the Appearance section, the Size option sets 
the size of the top and bottom label text (Small or 
Large); the Fitting options let you set the image 
thumbnail so that all of the image is displayed (Fit) 
or that it fills the frame of the thumbnail (Fill); and 
the Theme option lets you choose a Dark or Light appearance.
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The Labels section lets you adjust the displayed data for the top (right and left sides) and the bottom 
labels in each thumbnail, and how each label is displayed—all the time, or only when you mouse over the 
thumbnail. You can also choose whether to display the rotation arrows and edit badges (which indicate that 
the image has been edited inside Resize), as well as preview images for folders viewed inside Browse.

By default, the labels are set up to display the ratings and label information on the top left, the favorites 
state (like, empty, reject) on the top right, and the bottom displays the filename. You can however, set any 
of the three label locations to display any of more than 20 pieces of metadata, including filename, camera 
and lens information, exposure and ISO, capture date, ratings, image dimensions, and much more.

NOTE: Most of the data fields that you can display in the Thumbnail View 
Options are visible in the Metadata panel. See page 38 for more information.

Sorting photos in Grid view

When working in Grid view, you can sort the thumbnails 
in a number of different ways by choosing the Sort 
By pop-up at the bottom of the window. The sorting 
options include: date captured or modified; color label; 
file name, type, or size; and rating. 

You can also create a custom sort order by dragging 
thumbnails inside the grid window; click and drag the 
thumbnail so that the outline sits between two images. 

Once you change the order of images, the Sort pop-up 
changes to Custom, and Resize will remember the sort 
order for that folder until you change it. (Custom sorting 
also works when viewing albums.)

At the bottom of the Sort pop-up are settings for sorting the view in ascending or descending order; 
selecting one of the options will rearrange the view accordingly. If you have a custom sort order, choosing 
these options will change the view in the opposite order.

To reorder a photo in Grid view, drag it between the two photos 
where you want it to be placed.
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PHOTO (DETAIL) VIEW

In Photo view—also known as Detail view—you get a full-screen version of your photo. When you go to 
this view, your images will be displayed in Fit mode, showing the entire image. You can click on the image 
to zoom in to 100%. This is useful for judging small details and sharpness. Single-clicking on a image that is 
magnified will return back to Fit mode. You can click and drag a magnified image to look around. Your zoom 
mode is maintained as you move from image to image so you can compare the same spot in several frames.

When you view an image in Photo view and have the right-hand Photo panel open (as shown above), the 
Levels, Navigator (Nav) and Info panes will be visible as tabs at the top of the panel on the right. Clicking on 
the label will display that tab’s data. In the Navigator pane you can reposition the preview and change the 
magnification amount. The Levels pane displays a composite histogram of the image being displayed. You 
can also view and adjust the rating and flag labels for the current image, either via the keyboard or via the 
Info pane. (See page 37 for details on the Nav, Levels and Info panes.)

When working in Photo view, you can move to the next image by using the arrow keys on your keyboard, 
and you can add author, keyword, description and other information via the Metadata and Keyword List 
panes.
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FILMSTRIP VIEW

Filmstrip view presents a large version of your current image in the preview area, displaying other photos 
from the current view in a strip of thumbnails at the bottom of the screen. The photos are sorted by the 
current sort order, which can be changed via the Sort pop-up above the strip.

The current image is represented by a blue rectangle in the filmstrip, and you can use the arrow keys to 
move from photo to photo, or you can scroll with your mouse and click on a photo to display it in the 
preview. (You can also rate and flag images inside this view.)

When you view an image in Filmstrip view and have the right-hand Photo panel open (as shown above), the 
Levels, Navigator (Nav) and Info panes will be visible as tabs at the top of the panel on the right. Clicking on 
the label will display that tab’s data. In the Navigator pane you can reposition the preview and change the 
magnification amount. The Levels pane displays a composite histogram of the image being displayed. You 
can also view and adjust the rating and flag labels for the current image, either via the keyboard or via the 
Info pane. (See page 37 for details on the Nav, Levels and Info panes.)

Filmstrip view is similar to Detail view, but displays a strip of photos from the current folder (or album). You can easily move to another photo by using 
the right and left arrow keys, or by scrolling and clicking with your mouse.
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COMPARE VIEW

Compare mode is for those times when you shoot a sequence of photos of the same type of scene—a 
portrait session, a wedding, a landscape series, for example—and wish to narrow that group down to 
find your best ones. With Compare, you can select a group of photos, view them side-by-side to check 
composition, zoom in simultaneously to check focus, and rate your favorites and remove the rejects.

To use Compare mode, you can choose one of two methods:

• Select a group of images you wish to compare in either Grid or Filmstrip view. To select a 
group of contiguous photos (ones next to each other in order), simply click on the first one 
you wish to compare, then hold down the Shift key and click on the last photo. If you want to 
add noncontiguous photos, click on the first photo, then use the Command (Mac) or Control 
(Windows) key and click on each subsequent photo you wish to compare. When you have 
your selected photos, press the C key, or click on the Compare icon in the View Selector at 
the bottom left of the Browse window.

• You can also select photos directly in Compare mode: press the C key or click on the 
Compare icon in the View Selector at the bottom left of the Browse window. In the strip at 
the bottom of the window, you can select the photos in the same manner as the first option, 
by clicking on the first photo in a sequence, and Shift-clicking on the last, or by using the 
Command (Mac) or Control (Windows) key to select noncontiguous photos from a group.

When you enter Compare, you will see your selected photos in a grid in the Preview area, fit to show the 
entire photo. The currently selected photo will have a blue box around it, while the other items in the 
selection will have a light gray box around them. You can switch the primary selection by using the arrow 
keys on your keyboard, or by clicking inside the pane you wish to make primary. 

Compare mode displays selected photos as panes inside the preview area. The photo highlighted with a blue box is the current selection. Clicking in 
that pane will zoom the photo; if the Lock pan/zoom box is checked (above the filmstrip), then all of the compared photos will zoom with it.
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If you click once inside the current selection, the photo will zoom in to show greater detail; if you click and 
hold the mouse button down, you can pan across or down your photo, so you can check for things like 
detail, sharpness or facial expressions. (Clicking a second time inside the pane will reduce the photo to fit all 
of it in the pane.) 

To see the detail across the group of selected photos, click on the Lock pan/zoom dot above the filmstrip. 
Now, when you click on an area inside the primary photo, all of the photos will zoom simultaneously to the 
same location of your click. And, if you click and drag inside the primary photo, all of the selected photos 
will pan along with the primary. To pan one photo—which can be useful if the field of view was different 
than the rest—click on that photo to make it the primary selection, then hold down the Shift key and click 
and drag inside that pane. If you do this and wish to get back to the original zoom position, click on the 
Sync button next to the Lock pan/zoom setting, and it will reset the zoom view to the same place in each 
compared photo.

Use the spacebar if at you want to zoom between fit and 100% on the selected photo in the grid. Toggling 
the spacebar between views does not “lock” and will not sync with other photos even if Lock is turned on.

If you wish to remove a photo from the group, select it (by clicking on it or by pressing the left or right 
arrow keys) and press the / (slash) key on your keyboard. The photo will be removed from the Compare 
window, and the remaining photos will resize to best fill the available space in the window. (You can also 
add additional photos to the Compare window by using the selection techniques mentioned above.)

When using Compare, you can rate or flag a photo, apply a preset and add other metadata. These functions 
will only be applied to the primary selected photo (outlined in blue). There are two exceptions:

• Using the Sync settings button on the far right side of the Browse window, underneath the 
Info pane. Clicking on that will sync all of the Edit settings between the primary selection and 
all of the items being compared.

• Using the Create Album or Add to Album commands from the Albums menu: this adds all of 
the currently selected photos to either the new album (when you check the Add Selected 
Items button) or to the chosen album. This feature can be helpful when you have a group of 
images that you would like to keep for a client or to further segment a series.
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MAP VIEW

Resize’s Map view provides a simple mechanism to add GPS information to a photo, by searching for a place 
on a web-based map, or to view the location of a photo that already has location information embedded in 
its metadata. An internet connection is required to add or view map data.

The Map display has three controls: the buttons in the upper left 
corner of the map, to switch between Street and Satellite views; a 
search area, which lets you look for a place (cities, counties, roads); 
and the controls on the lower left, which let you zoom in or out of 
the current map view. To move around the current view, click and 
drag inside the window. The filmstrip at the bottom of the window 
displays other photos in the current folder. To move between photos 
you can use the left and right arrow keys, or you can use the mouse 
to select a new photo.

To view the location of any GPS-tagged photo on a map, select the 
photo and click on the Map view icon at the bottom of the main 
Browse window.

To add GPS data to a photo, select a photo or group of photos and 
click on the Map view icon at the bottom of the screen. There you 
can search for a location via the search bar. Once you have the 
desired area, right-click on the map to add a location for the photo (or 
photos) in that spot. If the position is correct, click inside the pop-up 
box to set the pin. 

If you would like to choose a different point instead, right-click in 
another location. 

Right-clicking on a spot on the map will 
generate this pop-up. To confirm the location, 
click in the box; otherwise, right-click 
elsewhere to choose a different map location.

Resize can automatically add standard location 
information, such as city, state, and country, to 
any photo that has GPS data. Choose Set 
Location from GPS Coordinates from the Photo 
menu in Browse..
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Once added, Resize will enter that position in the GPS field of the Metadata panel. 

Resize can also look up standard location information — city, state, country — from the GPS coordinates 
in a photo, and populate that information in the Location tab of the Metadata pane. To do this, click on 
the photos you wish to update and choose Set Location from GPS Coordinates from the Photo menu. (See 
“Metadata Pane” on page 38 for more information.)

My Catalogs and Browse Panels
On the left side of the Browse window are two tabs, My Catalogs, which displays your cataloged folders, 
and Browse, which displays the local drives and cloud services on your computer. To switch between the 
panels, click on the appropriate tab at the top of the panel. You can hide the left panel completely by 
clicking on the Show/Hide Panel icons at the bottom left and right sides of the panel. (Pressing the Tab key 
will show and hide both the right and left panels simultaneously.)

The Browse panel includes a 
Favorites pane, where you can 
add and access frequently visited 
folders, as well as a list of your 
local drives and cloud storage 
services.

While the top panes in the panels 
represent two views of your 
library, they share four panes: 
Albums, Dates, Advanced Search, 
and Recent. When using either panel, the content of these panes remain identical. The Browse panel 
includes a list of all your local drives and cloud storage services, while the My Catalogs panel lists all of your 
cataloged folders.

NOTE: Earlier versions of ON1 Resize combined the Cataloged Folders and 
Local Drives tabs into a single Browse panel. If you prefer that arrangement, 
check the Legacy Browse tab option in the General Preferences screen. (See 
“General Settings” on page 88.)

Navigating Sources

To view the contents of any folder in the Cataloged Folders or Local Drives panes, click on the triangle next 
to the folder name. This will display the photos and subfolders within the selected folder inside the Preview 
area. To view the contents of a subfolder, either click on the subfolder inside the Folders pane, or double-
click on it in the Preview area. (You can use the breadcrumbs bar at the top of the Preview area to navigate 
back to the top of your folder system.)

TIP: Any pane in Resize can be collapsed by clicking in the pane’s title bar; a 
Hide/Show link is visible when you move your cursor over the title bar. 

The My Catalogs tab (above left) displays your cataloged folders, while the Browse tab (above right) 
displays attached local drives and any cloud services you have installed on your computer.
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CATALOGED FOLDERS

A cataloged folder is a shortcut for your favorite or most-
used folders of photos. A folder designated as cataloged 
is cached in the background to improve the speed of 
loading those folders (and any subfolders) and their photos. 
Cataloged folders are ideal for portfolios, your favorite 
photos, or for your primary library of photos. Cataloged 
folders are necessary when using the Advanced Search 
feature to search for photos across multiple folders.

You can make any available folder a cataloged folder 
by clicking on the ‘+’ button at the top of the Cataloged 
Folders pane, or by dragging a folder from the Preview area onto the ‘+’ button. The cataloging process 
is designed to work in the background, so it doesn’t affect other work you do in any ON1 Resize 2022 
module. While the app is cataloging a folder, you’ll see a progress circle next to the folder name; once the 
folder has been cataloged, the circle will disappear. (Shown in the screenshot on the previous page.)

When you first catalog a folder, you will be prompted to choose the size of the previews that are generated 
during the cataloging process. The three thumbnail options are:

• Standard, which extracts the image metadata and EXIF thumbnail and creates a high-quality 
thumbnail and a fit-screen-sized preview.

• Medium, which extracts metadata, EXIF thumbnail and creates a high-quality thumbnail.

• Minimal, which extracts metadata and the EXIF thumbnail only.

For most purposes, you’ll want to choose the default preview size, Standard. If, however, you are working 
with a system that has disk space restrictions, or have a network connection to your cataloged folder, 
choose either Medium or Minimal. (You can change the preview size later by right-clicking on the folder in 
the My Catalogs list and selecting the Preview Size option.)

To remove a cataloged folder, right-click on the folder in the pane and choose Remove Cataloged Folder.

Adding photos to existing cataloged folders

You can add photos from any location inside Browse to an 
existing cataloged folder via the Copy to My Catalogs option. 
Then, when working in Browse, select the photos you wish to 
add, and choose Copy to My Catalogs from the File menu, or via 
the folder icon (with a ‘+’ button) to the right of the search bar at 
the top of the Browse window.

Inside the Copy to My Catalogs dialog box, you can choose 
which cataloged folder you wish to copy the photos, can add 
them to a new subfolder, and choose whether to move the 
photos or copy them. 

Moving the files is only available when you are moving the 
photos to a new location on the same drive; otherwise, a copy of 
the file is made in the new location.

The My Catalogs pane displays any folders you have cataloged. 
You can add additional folders by clicking on the ‘+’ icon at the 
top of the pane.
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FAVORITES, LOCAL DRIVES, AND CLOUD SERVICES

Resize’s cataloged folder feature is useful for keeping your 
primary photo library organized, but there might be times 
when you have a group of folders that you frequently access, 
but that you do not wish to have cataloged. (One common 
instance might be a folder where you export temporary 
images for social media or other uses.) In these cases, the 
Favorite folders option can be helpful. Any folder you 
designate as a Favorite will appear at the top of the Browse 
tab.

Adding Favorites

To add a folder to the Favorites pane, you can click the ‘+’ 
button in the Favorites pane. You’ll get your system’s file/
folder selection window. Navigate to the folder you wish to 
add, then click Open. Alternatively, you can navigate to your 
chosen folder in Browse and drag the folder onto the ‘+’ icon 
in the pane, or right-click on the folder and choose Add to 
Favorites from the pop-up menu.

Local Drives

Browse automatically recognizes any disk (volume) inside 
or attached to your computer. This includes internal and external hard drives, optical drives, thumb drives, 
digital camera memory cards, digital cameras, any devices that support USB Mass Storage, and network-
attached services (including mapped volumes on Windows).

Disks appear in the Local Drives pane with a hard drive icon next to them. Keep in mind that some disks, 
(like optical drives) are often read-only. You will be able to view a copy of a photo, but will be prompted to 
save the image to a new location if you wish to edit it.

Cloud Storage Services

Browse supports cloud storage services from Dropbox, Google Drive, and Microsoft OneDrive. These 
services—when installed on your computer and other devices—keep local copies of your images on your 
computer, and Browse finds and monitors these locations automatically. If you edit an image stored in one 
of these locations they are automatically updated to the cloud.

During the installation process, ON1 Resize 2022 automatically looks for the default installation locations 
for these services. If you do not have one of these services installed, or you have it installed to a non-
standard location you will be asked to install or locate the folder when you click on the source. You can 
hide services you don’t use in the Services tab in Resize’s Preferences (see page 91).

The Browse tab lets you add favorite folders for quick access 
to non-cataloged folders, as well as navigate to (and display)  
the contents of your local drives and any cloud storage 
services you might have on your computer.
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USING SHORTCUTS

The Shortcuts selector on the left side of the Browse panel is a list 
of icons designed to give you quick access to the Getting Started 
window, as well as six often used file locations, and display their 
contents in Browse’s Preview window. From top to bottom, the 
icons represent the Getting Started window, your Desktop, your 
Pictures folder, cataloged folders, local drives, cloud sources, and 
albums. Clicking on one of the icons will change the view of the 
Preview window to the selected shortcut.

By default, the Pictures shortcut uses your My Pictures folder 
(Windows) or Pictures (Mac). You can change the default location 
in the General section of the Preferences window (see page 
88).

Shortcuts can be useful when you have the right panel hidden to maximize viewing in the Preview window.

RENAMING FILES AND FOLDERS IN BROWSE

Browse offers two methods for renaming files or folders 
inside ON1 Resize 2022: single file and batch. 

To rename a single file or folder, click on it in Browse and 
choose Rename File from the Edit menu, or right-click on the 
item and choose Rename File from the pop-up menu. This 
will display a window where you can type in a new name for 
the item. Clicking OK will rename that file or folder.

Batch-renaming groups of files or folders

To rename multiple items in Browse as a batch, 
select them in the current view and choose 
Rename File from the Edit menu or the right-
click contextual menu. Resize will display the 
Rename window, which offers an array of 
options for renaming files based on custom text 
and image metadata.

In batch-rename mode, the Rename window has 
a central text entry field, where you can add any 
custom text you wish all of the renamed files to 
have. You can also insert a set of tokens (via a 
pop-up menu) that will be added to the renamed 
files. These tokens are in four main groups:

• Filename, which includes options for using the original filename, number suffix (taken from 
the image as recorded by the camera) and enclosing folder name.

• Date/Time, which includes a list of date (year, month, day) and time data that can be 
combined in various ways.

Renaming a single file or folder.

When renaming multiple files or folders, Resize’s batch-rename feature lets 
you use complex combinations of custom text and image metadata. You have 
the capability to save your custom rename settings as a preset to reuse at other 
times.
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• Sequence, which adds an incremented number to each renamed file in the batch, as well as 
the total number of files in the batch. Each of these token sets include options for leading 
zeros in the resultant filename. 

• Metadata, which lets you add specific EXIF and IPTC metadata to the filename.

NOTE: Resize’s Rename Files window is based on the Export function, which 
is used to export files with an extended array of options. A complete list of the 
tokens used in the Rename window, with explanations, can be found on page 
67, in the Export section of this guide.

To build a rename sequence using tokens, click on the Add Token button, and choose the appropriate token 
from the pop-up menu. The token will be added as a shaded item in the text field, and the Example item 
above the text field will show a sample of a renamed file using the current set of tokens and custom text. 
To change an existing token, click on the down arrow on the right of the token, which will display the full 
set of tokens. To delete a token, double-click on it and press the Delete key.

Custom text can be added anywhere in the entry field. You can click the cursor at the beginning or end 
of a token (or in-between tokens) and add spaces, dashes, underscores and any other text you wish to be 
included in each renamed file.

Because the Rename process is not undoable, make sure you use the Example field to check that your text 
and token combinations give you the filenames you expect for your batch process, and adjust as needed. 
When you’re sure, click Apply, and Resize will rename all of the files.

The Presets pop-up menu at the top of the Rename window includes a set of common batch combinations 
that you can use as a starting point. You can also create your own batch-rename presets: build the rename 
options you wish, and choose Save New Preset from the bottom of the Presets menu. You can also update 
an existing preset and delete presets from this menu.

NOTE: The Rename window remembers the parameters of your last operation, 
which can be helpful for creating presets.

MANAGING FILES AND FOLDERS IN BROWSE

A number of other file- and folder-management tasks are available in Browse; most of them can be 
accessed via the Browse menus, or from contextual menu that you can invoke by right-clicking in the 
Preview area of the main Browse window. 

Deleting a folder

To delete a file or folder, click on it and press the Delete key or right-click and select ‘Delete’ from the 
pop-up menu. Then, confirm that you wish to move the file to the trash. If you have multiple files or folders 
selected it will move them all to the trash. If you make a mistake you can use the Undo command, although 
some files or folders, like those on a network volume, are deleted immediately and cannot be undone.
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Creating a New Folder

You can create a new folder from the right-click contextual menu in the 
preview area or selecting Add Subfolder in the Edit menu. This will create 
a new folder inside the selected folder; if you have files selected in the 
preview area, you also will get the option to move or copy the selected 
images into the new folder.

Copying and Moving files and folders

You can copy and move files and folders in the ways you are accustomed 
to on your computer. You can select files and folders and use the Edit > 
Copy command to copy them to the clipboard and then Edit > Paste to 
paste them to new location, inside or outside of Browse. You can use this 
to copy a file or folder from one place to another or to attach an image to 
an email for example.

You can also use the familiar drag-and-drop functions to copy or move 
files and folders. Dragging and dropping a file or folder will move it if it 
is on the same drive or copy it to another drive. You can drag and drop in 
and out of Browse module.

Show in Finder/Show in Explorer

To view a file or folder in the Finder (MacOS) or Explorer (Windows), 
right-click on an image or folder in the Preview area and choose Show in 
Finder or Show in Explorer from the pop-up menu.

Changing a Folder’s Thumbnail Preview

By default, Resize chooses an image from a folder to use as the preview thumbnail for that folder. To 
change this, double-click on the folder icon and select a photo you would like to use as the thumbnail. 
Right-click on the photo and choose Set Folder Preview from the pop-up menu.

Right-clicking on a selection of files or 
folders in the main Browse window will 
display a set of file-management options 
for that selection.
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ALBUMS PANE

ON1 Resize 2022’s Albums feature lets you organize or keep track 
of photos on a project, event or even a broader category like a 
portfolio. Albums are created by selecting images manually and 
adding them to a new (or existing album) by dragging and dropping 
photos onto the pane. You can also nest albums together to help 
manage your collections.

Creating an Album

Click the ‘+’ icon in the pane and choose Create Album… from the 
pop-up menu. You can also create an album by selecting photos and 
dragging them onto the ‘+’ icon in the Albums pane.

Adding Photos to an Existing Album

There are multiple ways to add photos:

• Dragging and dropping a photo on the album name.

• Selecting a photo or group of photos, right-clicking on the 
photo and choosing Add to Album from the pop-up menu.

• Choosing Album > Add to Album and picking the destination album from the menu.

• You can also copy a photo and paste it into an album: click on a photo, choose Edit > Copy, 
then click on the album in the Albums pane, and choose Edit > Paste.

Removing Photos from an Album

To remove a photo (or photos) from an album, select them in the album, then choose Remove from Album 
from the Album menu, or right-click on the photo and choose Remove from Album from the pop-up menu.

Delete an Album

To delete an album, right-click on the album name and choose Delete.

Changing the Album Thumbnail Preview

To change the preview thumbnail of an album, double-click on the album name and select a photo you 
would like to use for the preview. Right-click on the photo and choose Set Album Preview from the pop-up 
menu.

Nesting Albums

To create a set of nested albums, first create a blank album by clicking on the + icon in the Albums pane. 
You can easily add sub-albums to that new master album set by dragging and dropping the desired albums 
onto the new one in the  Albums pane. When you click on the master album, Browse will display the albums 
that are part of that collection in the Preview area in a folder-style view. Double-clicking on an album icon 
will display the contents of that album. To view all the images in a master album set, click on the “Show 
Sub-Album Contents” button at the bottom of the Browse window.
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To move a sub-album from a master album to the top Albums level, drag and drop it out of the master, or 
right-click on the sub-album name and choose Move to Top.

To change the thumbnail of a nested album, double-click on the album name and select a photo you would 
like to use for the preview. Right-click on the photo and choose Set Album Preview from the pop-up menu.

NOTE: If you drag an album onto an existing album that contains images, you 
will see the top-level album’s images at the root level.

DATES PANE

Resize’s Dates pane offers a quick way to look for cataloged images 
based on when they were taken. Using a simple timeline interface, 
you can drill down into your photo library by year, month and day. It 
makes searching for things like birthday and holiday photos a snap.

Opening the Dates pane, you’ll see a list of years, with the current 
year at the top. Clicking on a year will show you all of the photos 
taken during that year, and you can click on the triangle to the left of 
the year to display a list of all the months that have photos in them. 
Drilling down to any level in the pane—year, month, day—will show all 
photos taken during that period.

The Dates pane works only with your cataloged folders.

When you click on a nested album set, Browse displays the sub-albums. Double-clicking on a sub-album will open that album. If you wish to view all of 
the images in a nested album set, click the Show Sub-album Contents button at the bottom of the Browse window.
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ADVANCED SEARCH PANE

The Advanced Search pane (known as the Filters pane 
in earlier versions of Resize) is designed to help you find 
photos in your photo library, based on a variety of criteria 
specific to photos and the metadata embedded in them. You 
can search based on any text associated with a photo, as 
well as likes, labels and star ratings, date, and keywords, and 
nearly any piece of metadata, from camera body and lens to 
aperture, ISO settings, time of day, and much more. 

Advanced Search options are flexible: they can be applied to 
the current folder view or album, or they can search any or 
all of your cataloged folders. You can also save any search as 
a preset style, so you can use it again in the future.

The pane has two modes: Basic and Advanced. In Simple mode, you can filter based on likes, star ratings, 
color labels, time, or basic text strings; all of the selections in this mode will match ALL of the chosen 
criteria to be found.

The Advanced option lets you find photos based on nearly every possible metadata type or textual 
information associated with a photo, and you can set the filter to match all or any of the chosen criteria. 

Using the Advanced Search pane

To perform a search, either type some text in the search box at the top of the Browse window, or click the 
button to the left of the Advanced Search label and set your criteria. If you want to filter based upon your 
cataloged folders, adjust the pop-up option underneath the pane’s text box. (To turn the pane off, click the 
Advanced Search button again.)

At the top of the Advanced Search pane is a set of common styles: Liked (any photo with the Like flag set), 
Five Stars, Recent (last 30 days), and Cataloged. Clicking on any one of these will run that specific search. 
Clicking on the More icon at the far right of the pane will give you a list of preset 
and user-defined styles, where you can choose additional filtering criteria, save 
the current search as a new style, or update an existing style.

Below the styles are other options for performing a quick filter operation: 

• Flags: Liked (represented by a heart filled in), disliked (X) or not set 
(empty heart). Click on the icon to turn that setting on.

• Star ratings from zero to five: Click on the greater than or equal symbol 
to the left of the stars to get a pop-up menu that lets you set the filter 
to show the exact number of stars, greater than or equal to the number 
of stars, or less than or equal the number of stars.

• Color labels: Clicking on the color will find all photos that have that 
label applied to them; you can select multiple color labels by clicking on 
additional colors.

• Date range: There are several preset relative date ranges in the pop-up 
menu. You can also set your own date range by choosing Custom from 
the menu, or by clicking on the calendar icon to the right of the pop-up.

Advanced Search’s basic view lets you quickly search your 
current folder view, album or cataloged folders on flags, 
ratings, labels, time and text.

In addition to the four preset 
styles at the top of the 
Advanced Search pane, 
others are accessible via the 
More pop-up.
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• Text search: Find images that contain the entered text in the filename, metadata, keywords 
or description.

• Filter Current Photos/Search Cataloged Folders: This pop-up lets you apply the current 
search to either the current Browse view will apply the filter to all of your cataloged folders.

Choosing these any of these options will find photos based on all of the options chosen (i.e. 3 stars AND 
the Red color label). To filter with additional options, or to filter based on any criteria (i.e. 3 stars OR the 
Red color label), use the Advanced section at the bottom of the pane.

TIP: Entering text in the search box in the top of the Browse window will 
automatically turn on the Advanced Search pane, and enter that text in the 
pane’s text field.

Using more advanced search options

The Advanced section at the bottom of the pane lets you add 
more discrete search options, choose multiple conditions to 
search upon, and set those options to filter on any or all of 
the criteria selected. Create an advanced filter by clicking on 
the Advanced triangle and choose either Match All Criteria or 
Match Any Criteria from the pop-up menu directly under the 
Advanced label.

By default, the pop-up underneath the Match menu is set to 
Everything, with an empty text box to the right of the option. 
If you would like to narrow the filter to more precise metadata, 
click on the pop-up menu and choose one of the advanced 
options from the list. These options range from camera 
metadata (Camera, Lens, Focal Length, Aperture, Shutter 
Speed, and ISO), to descriptive metadata (Keyword, Author, 
Description); to image-specific information (File Path, File Type, 
Orientation, Height in Pixels, Width in Pixels); to object type 
(Version, Original, Video). One other filter, Time of Day, lets you 
select images based on the time they were taken; you can choose Morning, Afternoon, Evening, or Night.

Once you’ve selected a filter, click on field to the right of the filter and enter (or select) the information 
upon which you wish to filter. Many of the advanced filtering options have pre-populated data taken from 
indexed metadata in your library, while others let you enter text into the selection field. (The Everything 
filter looks for text in all of the metadata associated with your photos.)

To choose additional filtering options, click on the Add button at the bottom of the Filter pane, and choose 
another criterion from the pop-up. 

Saving and modifying search results

If you find yourself using the same search operation over and over, you can save it as a style. Just create 
the filter and choose Save New Style from the More pop-up menu at the top of the pane and give the style 

The Advanced section in the search pane lets you 
choose from nearly every available type of metadata. 
Here, we want to find all cataloged photos created with 
a Sony RX1R2 camera tagged with the keyword 
‘portfolio.’
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a descriptive name. It will now appear at the bottom of the More menu. To delete a user style, choose 
Delete Style from the More pop-up and select the style you wish to remove. (You can only delete styles 
you have generated, not the default set installed with Resize.)

You can also update an existing style with changes made to the filter, whether it is one of the default filters 
or one of your own. To do this, select the desired filter in the pane, make the changes you wish, and select 
Update Style with Current Settings.

For example, you might want to change the Captured This Year filter to only filter on photos with 1 star or 
more. Choose the filter from the pop-up, then click on the 1-star icon, and update the style.

RECENT

The Recent pane keeps track of recently opened files or manually 
browsed folders. Files are listed in order of last opened. You can 
access your most recent files in this pane by clicking on the one you 
want and it will appear in your main preview window. The Recent 
pane only shows files you have opened from within Browse, not 
files you have opened as a plug-in from Lightroom or Photoshop.

You can clear the recent list by pressing the ‘x’ icon in the title bar.

The Photo Panel
The panel on the right side of the screen contains information relative to the currently selected image in 
the Preview area, and includes three sections: Nav, Levels, and Info.

THE NAVIGATOR PANE (DETAIL AND FILMSTRIP VIEWS ONLY)

This pane presents a thumbnail view of the current image. 
The white square region marks the image area that is 
visible in the preview pane. You can pan your image by 
clicking and dragging inside the square.

At the bottom of the Navigator pane are several zoom 
buttons representing percentage zoom views (100%, 50% 
and 25%). Click on one of the buttons to change the view. 
Fit zooms to fit the current canvas size, while 100 zooms 
to 100%, displaying the actual pixels.

THE LEVELS PANE (DETAIL AND FILMSTRIP VIEWS ONLY)

This pane gives you a color chart of the shadow, midtone and highlight areas based on an image’s RGB 
values (commonly known as a histogram). This is useful to show areas within the image that may be clipping. 
Clipping is when your image contains pure blacks or white and can signify loss of highlight or shadow detail.

The left side of the histogram represents the shadows, while the right represents the highlights. At the top 
of each end is a triangle. If the triangle is lit, there is clipping on that side of the histogram. If you click on 
the arrows, you will activate the clipping overlay on your image, which displays the areas that are clipped. 
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Those areas with a blue overlay are pure black, while the areas with the red overlay are pure white. You can 
turn the clipping view off again by clicking on one of the 
triangles. You can also temporarily enable clipping view by 
holding down the J key at any time. (Clipping can be 
turned on or off permanently by pressing Alt (Windows) or 
Option (Mac) and the J key.) The clipping view is useful 
when you are making adjustments to the brightness and 
contrast of your image.

The Levels pane also displays the RGB values under the 
cursor at the bottom of the pane.

INFO PANE (ALL VIEWS)

The Info pane displays common metadata and other 
information for the currently selected image in a large, 
easy-to-read format. This metadata includes: camera 
make and model; lens focal length; capture date and 
time; file type; ISO; shutter speed; aperture; exposure 
compensation; image dimensions; and file size.

If any of the metadata fields are unavailable they will be 
left blank.

METADATA PANE

The Metadata pane displays more complete metadata about a photo than 
the Info pane, and lets you add your own metadata elements, such as 
author, copyright, contact information, keywords and photo descriptions. 

In addition, at the bottom of the Metadata pane are three labels/tabs for 
viewing or adding specific types of information to your photos:

• EXIF (Exchangeable Image File Format) displays all of the data 
embedded by your camera. Depending upon the camera, some 
of all of this information will be displayed, and many of the 
fields are editable. 

• IPTC (International Press Telecommunications Council) is an 
industry-standard metadata format, and offers much more 
detailed metadata information than EXIF. It historically has 
been used by journalists and stock photographers to catalog 
and tag photos, as well as add copyright information, captions, 
and other data.

• Location includes GPS information, as well as country, state/
province and city information. Resize can automatically look up 
this information for any photo that has GPS coordinates, via the 
Set Location from GPS Coordinates item in the Photo menu.

Clicking on the label will display that tab’s information. 
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When you enter text into any field in the Metadata pane, Resize will add that information to the currently 
selected image. You can change the metadata in multiple images at the same time by selecting them all, 
then changing any of the fields in the pane.

Metadata templates

With ON1 Resize, you can create metadata templates that apply common information to your images, data 
such as copyright, author, contact information, your website and more. These preset templates can be 
accessed in the Metadata pane.

Saving a metadata template is easy: you can either go to an image that has the basic metadata items you 
wish to use, or you can select an image without metadata and add your common items to the Metadata 
pane. Once you have the metadata set, click on the Preset drop-down menu at the top of the pane 
and choose Save New Preset. The Save Preset dialog will appear on-screen, and you can choose which 
metadata fields you wish to save as part of the template. For example, while you might wish to save the 
copyright and contact information as part of your preset, you might not want to apply keyword, GPS or 
description data to a group of images. 

You can update a metadata template by selecting the preset in the pane, then changing the appropriate 
fields as desired, and then choosing Update Preset with Current Settings from the Preset drop-down. To 
delete a metadata preset, first choose the preset from the 
drop-down menu, then choose Delete Preset from the 
menu. 

Embedding Metadata

Metadata you add in Browse is stored in industry-standard 
XMP sidecar files for raw files. This facilitates the transfer 
of metadata to any application that supports XMP. When 
you edit an image, create a copy of an image for editing or 
use the ‘Send to’ command, the metadata is embedded into 
the file automatically (with the exception of raw files). You 
can manually embed your metadata into images using the 
Embed Metadata command from the Photos menu. This will 
open each image you have selected, update the metadata 
and re-save it. This is supported for TIF, PSD, PSB and JPG 
files; raw and PNG files do not support direct embedding of 
metadata.

Reading Metadata

Sometimes, when you’ve been sharing raw images across machines or with others, the metadata 
information might get ‘lost,’ or is different than your original metadata. In these instances, choose Read 
Metadata from the Photo menu, which will grab the metadata from the file or the XMP file (for raw files).

The Save Metadata Preset dialog lets you choose which 
metadata fields get saved to a preset from the currently 
selected image.
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KEYWORD LIST PANE

As you add cataloged folders or browse through folders of 
non-cataloged photos inside ON1 Resize 2022, any keywords 
you have added—to any photo—are stored in an internal 
database. That list of keywords is visible in the Keyword List 
pane, and from there, you can search for established keywords 
and display those photos from your cataloged folders, manage 
the keyword list, and apply keywords to new images. And, 
to help manage your keywords, Resize 2022 will also let you 
create subcategories of keywords (see “Using hierarchical 
keywords with Resize” on page 40).

If you double-click on a keyword in the list, Resize will search 
your cataloged folders for that keyword, and display the 
results in the Preview window. In this search, Resize is actually 
performing a search in the Advanced Search pane, so you can 
refine your search there, if you wish to add additional filter 
criteria. (If you would like to search the current folder only, 
choose the Filter Current Photos option in the Advanced 
Search pane.)

You can assign keywords to an image in any of Browse’s views. Click on the button to the left of a keyword, 
and Resize will apply that keyword to the currently selected image or images.

Right-clicking on a keyword gives you a pop-up menu with a list of options you can perform:

• Assign Keyword to Selected Photos: adds that keyword to the current selection.

• Remove Keyword from Selected Photos: removes that keyword from the selection

• Add Keyword: Lets you create a new keyword, with the option to save that keyword as a 
subcategory of the currently selected keyword.

• Edit Keyword: lets you rename the selected keyword, and applies the new keyword to all of 
the cataloged and known photos that used it.

• Delete Keyword: Removes that keyword from the cataloged and known photos that use it.

• Find Cataloged Photos with Keyword: Displays (in grid view) all of the photos in your 
cataloged folders that use the selected keyword.

Refining the Keyword List

Because the list of keywords can be extremely long, you can use the pane’s search field to look for 
keywords: as you start to type in the field, Resize will display a list of keywords that contain the letters 
you’ve typed. Once you’ve narrowed your search, you can select a keyword from the list (shown, right), and 
perform any keyword operations detailed in the previous section.

Using hierarchical keywords with Resize

In addition to standard keywords, ON1 Resize 2022 also supports the creation and use of hierarchical 
keywords. This option lets you “nest” keywords within a top-level keyword, which can be helpful to manage 
and categorize keywords. 



ON1 Resize 2022 User Guide Part 2: Organizing with Browse 41

For example, you might want to use a master keyword for states that you’ve visited—“California,” “Nevada,” 
“Oregon,” etc.—and use sub-keywords for places within the state, like “Death Valley,” “Joshua Tree”, “Valley 
of Fire” and others. 

Hierarchical keywords are displayed in the Keyword pane with 
a small right arrow to the left of the top-level keyword. Clicking 
on the arrow will display the sub-keywords for that master, 
with the number of images with that keyword on the right side. 
As is the case with standard (i.e. non-hierarchical) keywords, 
you can double-click on any of the nested keywords to show all 
of the photos in your cataloged folders that use that keyword.

To create a keyword hierarchy, first create your master 
keyword by clicking on the gear icon at the top of the Keyword 
List pane and choosing Add Keyword. Enter the name of 
the top-level keyword and click Apply. (If you have photos 
selected, and don’t want to add the new keyword to those 
images, uncheck the “Add to Selected” box before clicking Apply.)

To create a new nested keyword, right-click on the master keyword and choose Add Keyword from the 
pop-up. The dialog box should now give you a check box to nest the new keyword inside the top-level 
keyword, as well as to add the new keyword to any selected photos.

If you wish to create new hierarchies from existing keywords, it is best to first create your master keyword, 
as shown on the right, and `then drag any existing keywords onto that master. 

Culling Photos in Browse
Using a standard rating and label system, it is easy to sort and cull 
your favorites from the throw-away shots. Browse offers three 
ways, aside from keywords and subfolders, to mark and group similar 
images. All of these methods may be set several ways: from the 
Photo menu, the right-click contextual menu, clicking the badges on 
the image thumbnail or in the footer of Image view. There are also 
keyboard shortcuts associated with each classification option.

• Star ratings: Set from zero to five stars. Photographers 
often use five stars for their favorite images and one star 
for images they don’t want to keep, but you can use this 
system in whatever way works best for you. You can adjust 

Hierarchical keywords can help with keyword 
management, and are extremely useful when you wish to 
use primary and secondary categories for such image 
categories as locations, people, types of shoots, and so 
on.

To create a hierarchical keyword set, create the top-level keyword by choosing Add Keyword from the Keyword List pop-up. Then, right-click the 
top-level keyword and choose Add Keyword. There, you will have the option to nest the new keyword inside the top-level keyword. 

An example of a photo in Grid view with a 
ratings, color and favorite attached.
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the rating using the 1 through 5 keys on the keyboard. You can also clear the stars on any 
image with the ` (backquote or grave) key.

• Color labels: There are five color labels as well. Color labels are a great way to mark sub-sets 
of images for special handling. You can set the color ratings by pressing the following keys: 6 
(red), 7 (yellow), 8 (blue), 9 (green), 0 (purple).

• Likes: A common need for photographers is to mark their favorite images and the ones they 
want to delete. This is best accomplished with the Like classification. There are three options: 
Like (icon with a filled-in heart), Dislike (‘X’ icon) and Not Set (empty heart). By default, 
images are in the Not Set category until you change them. You can set your Liked images with 
the P keyboard shortcut, Dislikes with the X key, and clear settings with the U key.

Both star ratings and color labels are industry standards. When you use these tools, the settings are 
stored in the metadata and will be available in other photo editors and managers, like Lightroom. (Likes are 
proprietary and will only appear in ON1 Resize 2022.)

USE AUTO ADVANCE WHEN CULLING YOUR PHOTOS

ON1 Resize’s Auto Advance feature was designed to help you rank a group of images quickly: with Auto 
Advance turned on, when you apply a rating, color label or flag to an current image, Resize will make the 
change and automatically move to the next image.

Auto Advance can be turned on or off via the Photo menu.

Sending images to another application for editing
Browse lets you send images you are viewing to other applications 
for editing. This is done via the Send to option, which is available 
from the right-click contextual menu or the Edit menu. Browse 
automatically detects Adobe Photoshop, Lightroom Classic, and 
Photoshop Elements.

You can set up any application you want to send your photos to. 
Simply select the Send to Other Application option. Then select the 
application you want to send your photos to. The application will be remembered and listed with your other 
Send to options. (For example, if you use an email client you 
can add it to easily email photos.)

When you send an image to another application, you will be 
presented with the Edit in dialog box from ON1 Resize 2022. 
There you’ll have the option to send either the edited photo 
or the original, unedited image. If you choose to send a copy, 
you’ll have options for choosing the file type, color space, 
bit depth and resolution. If you use the same set of options 
every time, you can check the “Don’t ask me again” box in 
the window, and you won’t be prompted again. (To change 
this setting, go to the Files tab in Resize’s Preferences.)

The Edit In dialog, with the Copy Options section expanded.
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PART 3: USING ON1 RESIZE 2022
ON1 Resize lets you get the highest quality enlargements of your photos, using the patented, 
industry-standard Genuine Fractals algorithms to enlarge photos without the loss of sharpness 
or detail. It includes the following features:

• Complete control over adjustment size and resolution

• Crop and level

• Sharpening

• Multiple resize algorithms let you get the highest quality results with any subject matter

• Add film grain

• Crop to common preset sizes for different paper and screen sizes

• Add gallery wrap wings for printing on canvas

• Divide an image into tiles for printing mosaics or murals

• Crop, resize, and print all in one place without having to create a new file

• Hundreds of presets to create the desired size print and adjust options for your printer and 
paper combination

When Should I Use ON1 Resize?
ON1 Resize should be used as one of the last steps in your workflow before printing. The power of ON1 
Resize is in the concept of resolution on demand. You can work with a modest size file, which makes your 
editing faster and takes less hard drive space and memory. Then when you are ready to output your file, 
enlarge it with ON1 Resize to the desired size and sharpen it for output. This means you don’t have to keep 
multiple versions of a file at different print sizes; you just create what you need on the fly. ON1 Resize also 
supports layered Photoshop files so you can maintain all your layers in the entire process.

NOTE: A much fuller discussion of resolution and print size can be found in 
the “How Big Can I Print?” and “How Much Resolution Do I Need?” sections, 
starting on page 57.
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ON1 Resize Main Screen Overview

ON1 Resize provides you with an easy-to-use work area for editing your photos. Below is an overview of 
the main sections, including:

A. Tool Well: Includes the Crop and Zoom tools.

B. Settings/Help: This is where you can access preferences and help. The button at the bottom 
shows/hides the Presets pane.

C. Presets: Contains a library of presets for different printers, paper types and print sizes.

D. Search: Search for presets by name.

E. Preview Window: Preview of image to be resized.

F. Zoom view/Soft Proofing: Sets the zoom level and turns soft proofing on or off.

G. Tool Options bar: Lists options for the current tool. 

H. Navigator/Levels/Info Pane: Navigator, levels (histogram) and general photo information.

I. Pixel Dimensions: Displays the pixel dimensions of your image.

J. Document Size: This is where you set the size of your resized photo.

K. Resize Settings: Choose the image type, resizing method, and more.

L. Control Panes: Sharpening, film grain, tiling and gallery wrap options.

M. Reset All/Cancel/Done: Reset the current settings, cancel (and return to Browse or external 
application without saving) and save and close your image with the current settings.

N. Module Selector: Returns you to Browse.

O. Export/Share Buttons: Export or share your image (separately from Resize).
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Navigating the Preview Area
The Preview area is the main section where you preview and work on images. You can use the View tool for 
navigating this window.

This tool, which is the default tool selected when you open an image in the Resize module, adjusts the 
magnification of the image in the Preview window. With the Zoom tool selected, click in the Preview 
window to zoom in and center the image at the location clicked. 

Hold down the Option/Alt key to pan around the magnified image. You can also double-click the View tool 
in the Tool well to set the image to 1:1 (or 100%) magnification view, which shows every pixel. This is best 
when examining small details, and when previewing the effects of Resize’s sharpening on your photo.

NAVIGATOR, LEVELS AND INFO

At the top of the control panel on the right of the main window are the Navigator, Loupe, Levels, and Info 
panes. These four panes can be useful for inspecting and viewing details in your image.

The Navigator Pane

This gives you a birds-eye view of your image. The white 
square region marks the image area that is visible in the 
preview pane. You can pan view by clicking and dragging 
inside the white region.

At the bottom of the Navigator pane are several zoom 
buttons: 

• FIT: Zooms to fit the current canvas size.

• 100: Zooms to 100%, or actual pixels.

• 50: Zooms to 50%

• 25: Zooms to 25%

The Levels Pane

This gives you a color chart of the shadow, mid-tone and 
highlight areas based on the image RGB values (often 
called a histogram). This is useful to show areas within 
the image that may be clipping. Clipping is when your 
image contains pure blacks or white and can signify loss 
of highlight or shadow detail.

The left side of the histogram represents the shadows, 
while the right represents the highlights. At the top of 
each end is a triangle. If the triangle is lit, there is clipping on that side of the histogram. Clicking on the 
arrows will activate the clipping overlay. The areas of your image with a blue overlay are pure black, while 
the areas with the red overlay are pure white. You can turn the clipping view off again by clicking on one 
of the triangles. You can also temporarily enable clipping view by holding down the J key at any time. The 
clipping view is useful when you are making adjusts to the brightness and contrast of your image.
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The Levels pane also displays the RGB values under the cursor at the bottom of the pane.

The Info Pane

The info pane displays important photo metadata, 
including:

• Camera type

• File type

• Focal length and lens information

• Date and time captured

• Exposure information

• ISO

• Shutter Speed

• Aperture

• Exposure Value

• Filename

• Color Space

• Dimensions

• File Size

CROP TOOL

The Crop tool is used to 
crop and resize the entire 
image. Resize’s Crop tool 
removes any pixels outside 
a crop box and changes 
the canvas size at the same 
time.

To crop the image, select 
the Crop tool. Then adjust 
the corner handles of the 
crop tool overlay. The 
area outside the crop box 
appears darkened for 
guidance. You can resize 
and move the image inside 
the crop box. When you are 
satisfied, press the Apply button in the Tool Options bar or press Enter.

Working with the Crop Tool Overlay

• Moving the Image: To move the image inside the crop box, click and drag inside the box. You 
can also nudge the image using the arrow keys on your keyboard.

The Crop Overlay in Resize.
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• Resizing a Crop Box: To resize the Crop Box, click and drag on any of the resize handles. 
Clicking on a corner handle allows you to adjust two sides at the same time. Clicking on a side 
handle allows you to adjust that side. If you hold the shift key down while adjusting the size, 
the proportions of the box are maintained. To rotate the crop box, move outside a corner 
until the tool changes to rotate. You can also set the aspect ratio or size of the crop box in the 
Tool Options bar.

Crop Tool Options Bar

• Preset pop-up: Pop-up controls the crop tool mode as well as aspect ratio and document size 
presets.

• Width: Sets the width of the crop box.

• Swap Dimensions: Swaps the width and height. Handy for rotating the crop box.

• Height: Sets the height of the crop box.

• Units: Determines the unit of measure: Pixels, inches, centimeters, etc.

• Leveling tool: Click and drag this tool across an element in your image that should be level.

• Angle: See and adjust the angle of rotation.

• Rotate: Rotates the image 90 degrees.

• Cancel: Resets the crop tool.

• Apply: Applies the crop and resizes your photo.

Crop Tool Modes

The Crop tool works in three modes, which are all accessible via the Preset 
pop-up in the Tool Options bar:

• Freeform: In this mode you can adjust the crop box any way you like. 
The image will not be resized. Any area outside the crop box will be 
trimmed off. Use this mode if you just want to change the shape or 
recompose your image for general use.

• Aspect Ratio: You can lock the crop box to an aspect ratio. This 
makes sure the crop box shape doesn’t change, just the size. Use 
this option to trim existing pixels while maintaining a ratio without 
resizing the image.

• Document Size Presets: These let you crop and resize your image 
at the same time. If you know your intent is to print the image at 
a certain size you can crop and resize the image at the same time. 
Many common sizes are included plus you can create your own.

The Crop tool preset pop-up 
includes options for nearly every 
aspect ration or print size.
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Leveling the Image

The Crop tool has a special Leveling tool for automatically rotating your image to be level. To access it, first 
select the Crop tool, then perform the following:

• Select the Leveling tool from the Crop tool options bar. Your cursor will change to the 
Leveling tool.

• Click and drag a line across your image that should be level, either horizontally or vertically. 
When you release the mouse the image will be rotated automatically to the correct angle.

ADJUSTING THE IMAGE SIZE

In Resize, you can adjust your image size using either the 
Document Size pane or the Crop tool options bar. The 
information in these areas are interrelated and locked 
together. Adjusting the values in either pane will lead to 
changes in the other pane.

The Document Size pane displays the current desired 
Document Size, or the original size if you have not 
adjusted anything. Type into the Width or Height fields 
to change the Document Size.

The Width and Height fields are locked together to 
maintain the photo proportions. Changing the width will 
change the height proportionally. Resize does not support non-proportional scaling. If you would like to 
change the proportions of the image, use the Crop tool.

The Document Size Presets make it easy to crop and resize your photo at the same time. Simply select one 
to set the width and height automatically. This also selects the Crop tool, so you can adjust the document 
size to fit your photo. You also control your resolution, known as pixels per inch or dots per inch. This is 
important to adjust based on your output device.

The Pixel Dimensions pane displays the image size in pixels, the file size, bit-depth and scaling factor.

Using Document Size Presets

Document size presets allows you to crop and resize your image simultaneously. Often, when you are using 
ON1 Resize it is to create a file for print output at a known common size. In these cases, using a Document 
Size Preset can be the fastest way to set your Document Size and 
crop your image to the needed proportions. 

Follow these instructions to use a Document Size Preset:

1. Select your desired size from the Document Size preset 
pull-down in the Document Size pane, or Crop tool 
Options bar. You will see that the Document Size fields 
will be completed automatically for you and that a crop 
box is drawn on your image matching the proportions of 
the document size preset that you selected.

The Photographic Document preset category 
contains many traditional print sizes.
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2. If needed, select the rotate crop box to rotate your crop box to the proper orientation. It 
will automatically rotate to match the orientation of your image, but if you want to crop 
differently you may need to rotate it.

3. You can use the Crop tool to reposition and change the size of the crop box so that it 
contains the image area that you want. Note that the crop box proportions and Document 
Size are locked so that you will always have the finished document size that you requested.

4. Adjust your resolution to what is needed for your output device. If you are unsure what to 
select, use the resolution drop-down menu for common settings.

Resize comes with many commonly used print, paper and video document size presets but you can also 
create your own:

• Select your image and launch Resize.

• From the Document Size Preset pull-down, select Custom > Manage Custom Sizes.

• Click on the Add button.

• Double-click on the highlighted untitled name and name your preset.

• Double-click on the width and height and fill in the proper values.

• Click on the units and select the proper unit.

• Click on the OK button.

TIP: If you select the incorrect Document Size Preset you can change it by 
selecting a different one. If you do not wish to use a Document Size Preset 
after you have selected one you can press the Reset button in the Document 
Size pane or the Cancel button in the Crop tool options bar. 
 Also, the Lock Crop option locks the proportions and document size settings 
for the given crop. This is on by default when you use a Document Size Preset.

You can easily create your own custom print size presets inside 
Resize.
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SETTINGS PANE

The Settings pane contains the controls for selecting and adjusting 
the resizing method (or algorithm) and its settings. Selecting the 
correct settings here can improve the quality of the results. 

Image Type

To help you get started, try one of the presets in the Image Type 
drop-down menu. This pop-up contains presets for different image 
categories (portraits, landscapes, etc.). Choosing one will adjust the 
settings for Texture, Threshold and Smoothness automatically.

Method

The Method drop-down selects the method, or algorithm, used to resize 
the image. The options are:

• Genuine Fractals: This is the classic, patented, fractal-based 
algorithm that has made Perfect Resize the standard for over a 
decade.

• ON1 Resize Portrait: This is a new variation on the Genuine Fractals algorithm designed for 
portrait images. It is slightly softer and does a better job representing skin and hair textures.

Texture Controls

When you select the Genuine Fractals method there are several other controls—Texture, Threshold, and 
Smoothness—that tune the resizing algorithm based on the image. These all have to deal with the texture 
of the image. If you were to analyze an image from a detail perspective you could break it into three 
categories: Edges, Continuous Tone and Textures.

Edges are the sharp details that define the edges of the subject in your image. It’s paramount that these be 
maintained in order for your enlargement to maintain quality. Continuous tone areas—like skin or skies—are 
mostly solid or graduated color. These resize easily as there is little detail in these areas.

Texture, in Resize’s nomenclature, are the areas that fall between these two. They are areas that still 
contain detail but are not sharp edges. These are things like the surface of rocks, tree bark, fabric, animal 
fur, etc. The amount of detail in these texture areas can have a large impact on the perceived sharpness and 
quality of an image.

With ON1 Resize you can control the key algorithm variables that effect these areas. And, you can use 
presets for different image types and subject matters that help you get the best results in reproducing 
these textured areas.

Here’s how to think of the sliders in the Settings pane, as you adjust the look of an image:

• Texture: This controls the amount of detail in flat, non-edge areas of an image. If your image 
contains lots of small detail that does not have defined edges (many organic patterns like 
leaves, rock, bark; or man-made patterns like fabric) it may be good to increase the amount 
to a setting of 4 or 5. Settings beyond 5 will often introduce a bumpy noise pattern which 
is undesirable unless your original image was from scanned film. Settings lower than the 

Options for the Settings pane’s Image 
Type menu.
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default 3 are useful for images with large areas of continuous tone that have no appreciable 
detail (sand, snow, sky) but have hard edged foreground subjects such as landscape images, 
architecture or portraiture.

• Threshold: This controls the amount of hard edge detail that is enhanced. The default setting 
is 25. Decreasing the threshold will focus the algorithms on edge information. This may 
be useful for portraiture or for reducing noise in your image. Settings higher than 25 will 
increase the amount of small detail in flatter areas of the image. Settings as high as 100 are 
useful for highly detailed images (hair or feathers). Higher threshold settings will also make 
ON1 Resize process faster. A good way to start adjusting these controls is by setting the 
threshold to 100 and then move the Amount up until the image is too noisy (bumpy) and then 
reduce the threshold to smooth out the noise in continuous tone areas. For detailed images 
with no little or no continuous tone, you might try the amount at 4 and the threshold at 
100. For portrait images or images with JPEG artifacts you should try an amount of 2-3 and 
threshold of 25 or lower.

• Smoothness: The smoothness slider is used to reduce artifacts along hard curved edges. Use 
the lowest setting needed.

The last item in the Settings pane, Preview Using Genuine Fractals at 100%, will use that algorithm to 
preview quality at 100% zoom, so you can more accurately adjust the items in the settings pane, as well as 
controls in the Sharpening pane.

SHARPENING PANE

The Sharpening pane contains the controls to add additional 
sharpness to your image.

ON1 Resize features three sharpening methods:

• Unsharp Mask: Good for general sharpening. Similar to 
Photoshop’s Unsharp Mask function. Resize’s sharpening 
is different in that it is only applied to the luminance of 
the image, to prevent color artifacts.

• High Pass: High Pass sharpening is helpful when the 
original image is not sharp.

• Progressive: Similar to Unsharp Mask, except it sharpens 
different amounts depending on the size of the details 
in the image. Small details are enhanced more than large 
ones.

Using the Sharpening controls can save you the workflow step of adding additional Sharpening before 
printing and can help compensate for loss of sharpness due to dot gain from your printer. Sharpening 
should only be applied at the end of your workflow just before printing. If you plan to do additional 
retouching or compositing work after resizing your image, you should disable the Sharpening controls.

To sharpen your image for output, use these steps after you have adjusted the Document Size pane 
controls:

1. Zoom in on your image to 1:1. You can do this easily by using the 1:1 Zoom preset located in 
the Navigator pane.
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2. Enable the Sharpening controls by toggling the on/off control in the pane’s title bar.

3. Select the sharpening method that will provide the best results for your image. You may 
need to experiment to determine this.

4. Adjust the amount slider to determine the amount of sharpening desired.

5. Use the Highlight and Shadow sliders to limit the sharpening from being applied to the 
darkest and lightest areas of the image which can prevent sharpening of noise.

6. Similarly, adjusting the Skin slider can help protect skin tones from being oversharpened in 
the resizing process.

FILM GRAIN PANE

The Film Grain setting controls the amount of simulated Film Grain 
(noise) to your image. Adding a modest amount of grain can make 
your image appear sharper visually and can help hide imperfections 
(such as JPG artifacts).

Adding film grain can be especially useful for monochrome images, 
and should be added just before printing. If you need to do other 
retouching or compositing work in Photoshop or Layers after 
resizing your image, you should disable the Film Grain controls in 
Resize.

To add Film Grain to your image follow these steps:

1. Zoom in on your image to 1:1. You can do this easily by using the 1:1 Zoom preset located in 
the Navigator pane.

2. Enable the Film Grain controls by toggling the on/off control in the Film Grain pane title bar.

3. Adjust the slider up or down until the desired amount of Film Grain is added.

You can preview just the effect of the Film Grain by toggling the on/off control in the pane’s title bar.
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TILING PANE

The tiling feature in Resize divides an enlargement into smaller pieces so that the image can be printed 
on a smaller printer. For example, you might want to create a mural that is 8 feet tall by 12 feet wide, but 
your printer can only print 24-inch wide strips. With the tiling feature you could automatically create four 
separate files that are 24 inches wide and 8 feet tall, to create your mural in sections.

With the tiling feature all you do is specify the size of paper you have to print on and if you would like the 
pages to overlap. Then ON1 Resize will resize your image and section it down into the individual tiles.

To use the Tiling pane:

1. Turn Tiling on by toggling the button in the pane header.

2. Set the Width and Height fields to the size and 
orientation of paper that you wish to print on, or you 
can select the number of rows and columns instead.

3. Set the Overlap size. The overlap makes each tile 
overlap so you can tape multiple panels together and 
corrects for printer margins if you are not printing 
borderless.

4. Set the file type for the newly created files for each tile.

5. Set the destination folder for the new files. Each file will be named with the original filename 
and the tile indicated in the filename.

The preview will show cyan guide lines for each tile that will be created. The bottom of the Tiling pane will 
tell you how many tiles will be created.
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GALLERY WRAP

The Gallery Wrap feature is designed to help you print on canvas. When making enlargements for canvas it 
is common to wrap a portion of the image around wooden stretcher bars. These can be several inches thick 
and help mount the canvas. These are commonly called gallery wraps. However, if you had important detail 
near the edges of the image, it might be lost in the wrapping process. ON1 Resize’s Gallery Wrap feature 
automatically creates extended margins by reflecting or stretching the areas near the edge of the image 
without having to sacrifice any of the original image. You can select the thickness of the mounting bars and 
use different options for creating additional margins.

To use the Gallery Wrap feature:

1. Turn on Gallery Wrap in the pane’s title bar.

2. Set the Thickness control to the amount of margins you 
would like to add. A good rule of thumb is to use the 
thickness of the stretcher bars, plus half an inch.

3. Select the Type you would like to use (see the list below 
for details on the different options).

4. If you wish to add a color overlay to the gallery wrap 
wings set the color and opacity.

The Gallery Wrap feature has several settings for adding margins and adjusting the look of the wrap:

• Reflect: Copies an area equal to the thickness setting around your image, then flips each side 
and adds it as the margins. This is a good general-purpose technique.

• Reflect Soft: Does the same as the Reflect method but softens the added margins.
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• Stretch: Takes a small area around the edge of the image and stretches it to add the margins.

• Stretch Soft: Does the same as stretch, but softens the added margins.

The Thickness slider controls how thick your canvas stretcher bars are. Two inches generally works well for 
most gallery wraps.

You can darken the wrap or add a solid color to the wrap area with the Overlay Color and Opacity sliders. 
(The Opacity’s default is 0, which means that there is no color overlay added.)

The Add to New Layer option places the wrap wings on their own layer, rather then merging them with the 
image. This only applies when working via Layers or Photoshop in a layered workflow.

PRESETS

Resize has a preset system built into it, which is designed to help you get 
very specific crops for a wide range of paper and printer types. These 
include settings for photo lab print sizes, and many Epson, Canon and HP 
large-format printers, with Matte, Resin Coated, and Canvas types.

In addition to being able to set document size and settings, and settings in 
any of the other panes, Resize presets always contain a Crop adjustment. 
What that means is that any time you apply a preset, Resize selects the 
Crop tool and places the crop overlay on top of your file. There, you can 
move the overlay to the appropriate crop area (or resize the crop) for your 
photo.

To apply a preset, choose the category you would like to use from the 
Presets panel. The category will expand to a list of the available presets 
for that group. Then, just click on the preset you want to apply.

Saving a Preset

Once you have your settings that you wish to save, go to the Preset menu 
and select Save Preset, and choose a category you would like to save it 
in. If you have applied a preset to an image and make adjustments to any 
of the settings in the left panel, you can update that preset with the new 
setting by choosing Update Preset with Current Settings from the Preset 
menu.

To delete a preset, right-click on the preset in the Presets Browser and 
choose Delete Preset.

NOTE: You can also import and delete Resize presets from 
within the Extras Manager. See “Extras” on page 9 for 
more.
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Soft Proofing in Resize
ON1 Resize’s soft proofing feature lets you see how a photo will look when printed, using the color profiles 
that get installed with your printer. Soft proofing helps you determine where there might be issues when 
you print, so that you can adjust your tone, color and effects to give you a print that is closer to your 
editing vision.

Normally, when you’re viewing an image in Resize, you are viewing it through the lens of your monitor’s 
display profile. The color gamut of your computer’s display is wider than that of most photo printers, which 
means that some colors you are able to view 
on-screen are not reproducible when you print. 
When this happens, the color profile conversion 
that happens in the print engine will cause 
substitutions of colors that the printer cannot 
print to the closest color that it can. This means 
that your image could have subtle (or broad) 
shifts in color, especially in certain color ranges.

Soft proofing is turned on via the View menu, or 
by clicking on the soft proofing icon to the left of 
the Preview button at the bottom center of the 
main Resize window. The background of the main 
preview window will change to approximate the 
color of the paper you’re profiling. 

Additional soft proofing options are available 
underneath the Enable Soft Proofing command in 
the View menu. The options are as follows:

• Gamut warning: When checked, this 
displays a red overlay for colors in the 
image that are out of gamut for the 
current print profile.

• Profiles: The Profiles submenu lists 
the currently available printer profiles. 
Choosing one will change the on-
screen display to use that profile.

• Intent: Resize offers two different 
rendering intents when soft proofing, 
used to convert the color from display 
to print. Perceptual shrinks the color 
gamut, which works to preserve the 
relationship between colors in the 
image. Relative only converts colors 
that are outside the current color 
gamut; this can sometimes cause two 
colors, one in gamut, and one outside, 
to be identical after conversion.  

These three screen shots show the results of soft proofing options, as viewed 
in Resize. The top image is with soft proofing off (and is using the display 
color profile). The middle image is with soft proofing turned on, and using a 
printer profile for Epson’s Exhibition Fiber Paper. The bottom image has the 
Gamut warning turned on; out of gamut colors are highlighted by the bright 
red overlay.
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 Neither rendering intent is perfect or desired; it often is a matter of the makeup of the 
image, your editing intent, the paper being printed on, and so forth. Often, you’ll want to 
switch back and forth between Relative and Perceptual, seeing which gives you a better print.

• Simulate Paper and Ink: Turning this setting on will cause Resize to use the white point for 
the chosen paper type (instead of the white point of your monitor), and the paper’s actual 
black density (instead of the display’s black point). If you’re trying to match a print, you will 
usually want this setting turned on.

Adjusting images with soft proofing is often a bit of trial and error. It’s easy to get caught up in eliminating 
out-of-gamut colors, but most modern photo printers—both home printers and online print services—do a 
pretty good job of approximating colors properly. 

The biggest thing you want to be looking for when viewing a soft proof is tone, contrast and color accuracy 
between screen and print. 

Understanding Resize: How Big Can I Print?
People often ask how large a print can be made with ON1 Resize. If your original image is sharp, has good 
details and little noise, you could go as large as 1000% of the original size. 1000% is ten times the size of 
the original file. For example, an original file that is 8" x 10" could be resized to 80"x100". Viewing distance 
plays a big part of this. Standard viewing distances are two-times the diagonal of a print. For example, for 
an 8"x10" it would be about two feet away. An 80"x100" would be about 21 feet. That seems like a lot 
but that image is almost 7'x9'. Keep in mind that many photographers scrutinize their images closer than 
standard viewing distances.

Images are perceived in color, tonality and sharpness. Other interpolation techniques maintain color and 
tonality but sacrifice sharpness by “inflating” the image uniformly. The image still looks familiar but will not 
be crisp. Depending on the amount of interpolation, this can be severe and noticeable even at standard 
viewing distances. ON1 Resize maintains the color, tonality, and sharpness of an image at all sizes. It will 
always look the same when viewed at the proper distances.

It is unrealistic to assume that the fidelity when viewed at 100% will be the same for an 8×10 and an 
80×100 created by ON1 Resize. ON1 Resize will maintain the edges which perceptually make the image 
sharp, but it cannot create detail where there was none in the past. When the shutter is pressed, a finite 
amount of detail is captured. A good way to think about this is to look at an insect on a leaf. If you look at 
it with a magnifying glass, you will see more detail than you did than when looking at it with the naked eye. 
Now if you take a digital photograph of that same insect and look at it in the computer and zoom in past 
100% you do not see any more detail. The information you see is limited by what the camera captured. 
ON1 Resize works the same way, it cannot create new detail but instead takes the finite amount of detail 
available and increase it in size.

ON1 Resize isn’t magic. We have all watched CSI, where they take a security photo and enlarge the 
reflection in the victim’s eye to see the killer, with results that look amazing. This is science fiction. You 
cannot create detail where there was none before. But if your original file has good detail and little noise, 
you will be able to make very good looking enlargements from your files. This is what ON1 Resize does 
better than any other software.
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How Much Resolution Do I Need?
To answer this, you need to know two things:

1. The size of the print you need to make.

2. The resolution that your printer needs for best results.

The size of the print is as large you would like. This may be limited by the size of your printer. Resolution 
is the density of the pixels for a given distance, usually measured in pixels or dots per inch. Most modern 
inkjet printers print anywhere from 1200 to 4800 dots per inch (what the printer manufacturers really 
mean is 1200-4800 droplets of ink per inch). Inkjet printers use many tiny round droplets of 4-12 ink colors 
to reproduce one square pixel in your image that could be one of any millions of colors. A common mistake 
is to set the resolution of the file to the resolution of the printer. In all but a few special printers this will 
lead to huge files that will not print well, if at all. The secret is that the human eye cannot see more than 
250-300 pixels per inch. So the ideal resolution for your files should be close to this. Once you know the 
print size and resolution, it is easy to use ON1 Resize to resize your file to the desired output. Simply input 
the resolution and then either the print width or height. You’ll see that the corresponding dimension is 
automatically filled in by ON1 Resize based on the proportions of your image.

Keep the proportions in mind because the proportions of film, digital camera sensors and paper can all be 
different. For example, most digital camera sensors are proportioned so that the height is two-thirds the 
width or 1:1.5; While the most common paper size, in the US, is the letter which is 8.5×11 inches or about 
1:1.25. These kind of proportion mis-matches are common and require that the original image be cropped 
to fit the proportions of the paper size. If your image cannot be cropped without ruining the composition 
then you will need to adjust your print size to a longer dimension.

Resizing an image larger than the original size requires new pixels to be created. This process is called 
interpolation or resampling. There are many mathematical ways, called algorithms, to do this. The most 
common method used by many pixel editing applications is called bicubic interpolation. Bicubic along with 
its newer variants bicubic smoother and bicubic sharper work by averaging a small group of neighboring 
pixels to determine the color value of the new pixels to be added. While this technique is fast, it does not 
distinguish edges so there is a uniform loss of sharpness and detail across the image.

Resize’s patented scaling algorithm is fundamentally different from bicubic or other interpolation methods. 
While other methods sample nearby pixels and decide new pixel values one by one, ON1 Resize uses a 
sampling technique called Fractal Scaling. Fractal Scaling samples nearby “blocks,” square groups of pixels, 
and varying sizes, compares them to smaller versions of the original image and mosaics these patches 
together to create a larger version of the original. By doing this repeatedly, often the characteristics of the 
image like edges, smooth areas, and textures are reinforced for each larger version. Noise is de-emphasized 
and sharp details are maintained. All this number crunching may take a bit longer than the single pass 
interpolation methods like bicubic, but good things come to those who wait and the reward is far superior 
results.
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Export
Export is a special function that is available throughout ON1 Resize 2022, whether you’re 
working from within Browse or Resize. The Export window gives you much of the power of 
Resize in an easy to use panel, letting you export your photos with incredible flexibility, ease 
and control.

The Export window is separated into two panels: Export Presets and Export Options. The Options panel 
contains specific types of options—file renaming, destination folders, file type and more—that you can use 
when you are exporting images from Resize. If you find that you are using a specific set of options all the 
time for your workflow, you can create a preset and apply that whenever you use Export.

The contents of the Export window include:

A. Export Presets: The current preset (if used), will be represented with a selection box around 
it, and the filled circle to the left of the preset name means that it will be used when the 
Export button is pressed. To use the Export Options panel without any preset applied, turn 
off all of the presets in the list, and click in the current preset once.
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B. Save Preset: Lets you save the current set of export options as a preset.

C. Naming: Renames the exported file based on criteria added to the rename box in the panel.

D. Destination: Lets you set the destination of the exported files. (required)

E. File Type: Sets the file type for each exported file. (required)

F. Resize: Adjusts the size for each image. 

G. Sharpening: Applies sharpening to the exported images.

H. Metadata: Adds/removes metadata from the export. 

I. Watermark: Lets you add a text or graphic watermark to an exported image. 

J. Export/Cancel: Starts the exporting, or cancels it and returns you to Resize.

 Export Options

NAMING

The Naming pane gives you extensive controls for creating customized filenames using tokens in the entry 
box inside the pane, as well as with any custom text entered directly into the entry box. You can use any 
combination of tokens and text in the entry box, and the Example label directly above the box will display 
what your new filename will look like, using the 
first item in the export group.

To use this feature, click the control circle to the 
left of the label in the panel. Add any custom 
text, or click the Add Token pop-up menu to add 
tokens based on information associated with the 
image, including filename data, date and time 
information, and associated metadata There are 
four submenus in the Add Token menu:

• Filename, which includes options for using the original filename, number suffix (taken from 
the image as recorded by the camera) and enclosing folder name.

• Date/Time, which includes a list of date (year, month, day) and time data that can be 
combined in various ways.

• Sequence, which adds an incremented number to each renamed file in the batch, as well as 
the total number of files in the batch, with options for leading zeros in the resultant filename. 

• Metadata, which lets you add specific EXIF and IPTC metadata to the filename.

To build a rename sequence using tokens, click on the Add Token button, and choose the appropriate token 
from the pop-up menu. The token will be added as a shaded item in the text field, and the Example item 
above the text field will show a sample of a renamed file using the current set of tokens and custom text. 
To change an existing token, click on the down arrow on the right of the token, which will display the full 
set of tokens. To delete a token, double-click on it and press the Delete key.

Custom text can be added anywhere in the entry field. You can click the cursor at the beginning or end 
of a token (or in between tokens) and add spaces, dashes, underscores and any other text you wish to be 
included in each renamed file. Each change you make will be updated automatically in the Example label.
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The Presets pop-up menu at the top of the Rename window includes a set of common batch combinations 
that you can use as a starting point. You can also create your own batch-rename presets: build the rename 
options you wish, and choose Save New Preset from the bottom of the Presets menu. You can also update 
an existing preset and delete presets from this menu.

Because the Rename process is not undoable, make sure you use the Example field to check that your text 
and token combinations give you the filenames you expect for your batch process, and adjust as needed. 
When you’re sure, click Apply, and Resize will rename all of the files.

NOTE: A complete list of the tokens used in the Rename window, with 
explanations, can be found on page 67.

DESTINATION

The Destination pane is where you set the 
desired location for the exported images. At 
minimum, you must specify a destination folder 
for your export, but the pane has a number of 
options for adjusting the export location:

• The Folder pop-up menu lets you 
choose the same folder as the original 
images, another folder, or, can be set 
to ask for a destination every time, 
which can be helpful when you’re 
using an export preset.

• Checking the Put in Subfolder option 
will export the images to the folder—
or, create a new folder, if it doesn’t 
exist—specified by option’s text field.

• The Existing Photos pop-up is for 
those times when there might be a 
naming conflict within the destination 
folder. Replace will overwrite the file 
with the new one being exported, Skip 
will leave the destination file alone 
and not export the new file, and Keep 
Both will add a number ‘1’ to the end of the filename of the exported file, preserving both 
files.

• Generate Subfolders will subdivide the export based on the exported file’s metadata, 
creating subfolders as necessary—or, if the folders exist, placing the exported file into the 
appropriate subfolder. This option uses the same token-driven scheme (and presets) used in 
the Naming pane.

• After Export lets you determine what to do when Resize completes the exporting process. 
Options include displaying the image location in the MacOS Finder or Windows Explorer, to 
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create a ZIP archive of the exported group, to open in another editing application, or to run a 
script.

FILE TYPE

Like Destination, File Type is the other required 
element for using Export. Resize can export in 
DNG, PSD, TIFF, JPG and PNG formats. With 
the exception of DNG and PNG, each file format 
has specific options in the pane:

• Original includes options for embedding metadata and saving an ON1 sidecar file with the 
exported images.

• JPEG includes options for JPEG quality and for attaching a color profile.

• Photoshop includes options for attaching a color profile, bit depth, and whether to flatten 
any layers in the original image.

• TIFF includes options for image compression (none, LZW or ZIP), attaching a color profile, bit 
depth, and to preserve transparency.

• DNG and PNG have no additional options.

The File Type pane also includes an estimated file size for the first item in the group.

RESIZE

The Resize pane lets you adjust the finished 
dimensions of the exported photos, using the 
patented Genuine Fractals technology found in 
the Resize tab of Resize. It has seven options for 
export: Dimensions, Long and Short Edge, Width 
and Height, Megapixels and Percentage. Each 
option has a different range of settings, and all 
have a setting for resolution (in pixels per inch, or ppi), as well as a Don’t Enlarge option, which, when set, 
will not upscale a file past its native image dimensions (but will still export the file). 

The Dimensions option is the most complex of the six Resize options, letting you set the exact pixel 
dimensions of the exported files, in terms of width and height. This option is best for when you are 
exporting single images, when all of your exported files have the same aspect ratio and orientation, or 
when you wish to fit the exported images to an exact size. 

The Common Sizes pop-up menu at the top of the pane options lets you set the final dimensions to any of a 
broad array of common paper, photographic ratio, square and video formats. You can also create your own 
specific sizes for re-use via this menu.

Click the lock icon to resize the images proportionally as you enter either the width or the height, or, if 
you wish to fit the images to an exact width and height, click the lock icon to turn it off. If an exported 
image doesn’t exactly fit the dimensions you set for Width and Height, Export will do one of two things, 
depending upon whether you have Fit in Dimensions or Fill Dimensions set in the pop-up to the right of the 
Resolution box.

The Resize pane, with the Dimensions option open.
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• Fit in Dimensions will fit the exported file inside the boundaries of the width and height 
settings.

• Fill in Dimensions will zoom the exported image to completely fill the boundaries of the width 
and height settings, essentially cropping the exported image. If the image’s aspect ratio is 
different from the width and height settings, the image will be filled from the center. 

The Dimensions options include one more setting, Rotate to Match Photo, which, when checked, will rotate 
an exported photo to maximize its orientation. For example, if you exported a group of images to fit a 
landscape orientation (longer width than height), any image that was in portrait orientation (longer height 
than width) would be rotated during export.

The remaining options in the Resize pane include:

Long Edge and Short Edge are useful when you want to lock one edge to a 
specific length or width and don’t care about the sizing of the other edge. 
Simply choose which option is the important one for your photos, enter the 
dimension, and Export will resize your images proportionally based on the 
chosen setting. When you’re exporting a group of images with different 
orientations (landscape or portrait), these options will ensure that all images 
have the same long or short edge dimension.

Width and Height will resize all of the images proportionally to the width 
or height defined, regardless of orientation. Exporting photos with different 
orientation will result in the width or height of every image being the same, 
depending upon the setting chosen.

Megapixels will export images to a specific megapixel count, while Percentage will enlarge or reduce the 
size of the exported images. Percentages below 100 will reduce the image, while those above 100 will 
enlarge the image.

SHARPENING

The Sharpening pane has two modes, Sharpen 
For and Manual. The Sharpen For pop-up 
menu lets you choose from six options, based 
upon your final intent. There are four options 
designed for print output, Glossy Paper High 
and Low, and Matte High and Low, and two 
option for display output (for social media or 
online sharing), Screen High and Low.

The Manual setting provides a bit more control 
over the output sharpening, letting you adjust 
the Amount (overall strength), Radius (detail) and Threshold (masks out areas that shouldn’t be sharpened 
based on contrast). 

Resize has seven options for 
exporting images.
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METADATA

The Metadata pane lets you set which pieces of 
metadata are exported—or not exported—with 
the images in the export set. You can choose to 
export all Metadata or by clicking the control 
circle to the right of the All Metadata label. 
If you click that label off, you can then select 
which metadata items you wish to save by 
clicking the appropriate label.

The metadata information exported is the same 
data found in the Metadata pane in Browse, and any metadata presets you have saved will be available 
from the Presets pop-up menu. For specifics on the different types of data represented in the Metadata 
pane, see page 38. 

When checked, the Remove Unmanaged XMP button only exports metadata that is represented in Resize’s 
Metadata pane; any other unmanaged image metadata from other apps will not be included. 

WATERMARK

The Watermark pane adds either text- or graphics-
based watermarks to an image, with options for 
size and positioning, opacity, font type, and more. 
You can import your own logos and save either 
watermark type as a preset for frequent use. 

The Watermark pane also gives you a representation 
of your chosen watermark (on the first image in your 
export group), so you can adjust the parameters of 
the watermark precisely.

To create a new watermark, turn on the pane by 
clicking on the control circle to the right of the label. 
Choose either a preset from the Presets menu or 
click on the Add Watermark button in the lower 
right of the pane and choose either Text or Logo 
from the pop-up menu. Once you’ve selected a type, 
the bottom of the pane will open with settings for 
the chosen option. If you change your mind, click the 
Cancel button to the right of the Logo or Text labels.

Using graphics-based watermarks

The Logo section of the Watermark pane lets you 
use either watermark files imported via the Extras 
Manager (see page 9), which will be displayed 
in the File pop-up at the top of the Logo section, or 
by clicking on the Import button to the right of the 
menu (which will add them to the menu). 
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Use the Position grid at the bottom of the pane to place your watermark, and use the Size and Inset sliders 
to move it within the area chosen. The Opacity slider adjusts the transparency of the watermark on the 
final image.

The Repeat Image button will repeat the logo graphic rightward across the image from the location chosen 
in the Position grid. If you wish to repeat the watermark across the entire image, choose one of the sections 
on the left side of the Position grid.

When working with graphics-based watermarks, make sure your watermark file is sufficiently large for 
your usage. For example, if you want it to appear 2 inches wide on a 300-ppi image, your watermark needs 
to be at least 600 pixels wide. Or if you want it to appear across an entire photo—such as when posting 
to social media—it needs to be the same size as what you are exporting for the web, typically over 1000 
pixels. Using a watermark file that is too small will create a pixelated watermark appearance. And, because 
most watermarks are overlays on top of an image, these files are usually PNGs with areas of transparency, 
although JPGs can also be used, depending on the logo.

Using text-based watermarks

When creating text-based watermarks, the Text 
section of the pane has an entry box for your 
watermark text, a font selection area, and the same 
Appearance and Position options found in the Logo 
section.

The text entry box can contain multiple lines of 
custom text, and has the same token-based naming 
options found in the Naming pane (discussed on 
page 61), which can be helpful when exporting 
informational slides or for other data-driven uses.

You can set the font from the pop-up menu, and 
the font color by clicking the swatch on the left side 
underneath the font name. The text style can be 
set to bold, italic or underline, and the alignment to 
left, center or right. If you’d like to add a background 
color to the text box, turn on the Color Fill button 
on the right side of the pane.

Use the Position grid at the bottom of the pane 
to place your watermark, and use the Size and 
Inset sliders to move it within the area chosen. 
The Opacity slider adjusts the transparency of the 
watermark on the final image.

Saving watermark presets

Both watermark types can be saved as a preset 
for re-use later. To save a preset, adjust your Logo 
or Text settings as desired, and choose Save New 
Preset from the Presets menu. If you wish to adjust 
an existing preset at a later time—with a new logo 
file, for example—choose the appropriate preset 

With text-based watermarks, you can not only create simple, single-line 
watermarks showcasing your business, but you can also create 
data-driven watermarks (using tokens) for presentations and the like.
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from the Presets menu, make your changes, and choose Update Preset with Current Settings from the 
Presets menu. You can also rename and delete watermark presets from this menu.

Exporting and Export Presets
The Export window has been designed to offer as much or as 
little complexity as you would like. At its simplest, you can set the 
Destination and the File Type to your desired settings, leave all 
of the other panes alone, and click Export. Resize will remember 
your last Export setting—including anything you did in the Naming 
pane—the next time you export, so you don’t have to worry about 
which settings need to be set, and which ones don’t. You can use 
the Show/Hide buttons in the title bar of each pane of the Export 
Options panel to display only those settings you want to see.

Once you have your settings the way you’d like, you can save them 
as a preset by clicking the Save Preset option in the Preset panel 
on the left. Then, when you click that item in the Preset panel, the 
Export Options will be set to the specifications of that preset.

The Export Presets panel will display a list of the currently 
available presets. If you have selected a preset, it will have a 
selection box (in the app’s accent color) around it, and if the control 
circle is filled, the preset is on, meaning that clicking the Export 
button will export using that preset. If you don’t wish to use a 
preset, click the control circles off on all of the presets in the list.

By default, each preset will have up to three lines of explanatory 
text underneath the preset name, displaying the file type—DNG, 
PSD, TIFF—and the Destination information. This can be helpful 
when you’re scanning presets for a specific destination, but you 
can also collapse the preset to its title by clicking the Hide button 
in the title bar.

When you change the settings for a selected preset, Resize will ask 
you if you wish to update the preset with the new settings either 
when you click the Export button to start the process, or when you 
switch to another preset with the Export window.

It is possible to export more than one preset at a time. Every preset 
in the Presets panel that has the control circle set to On (filled) will 
be included in the export operation. This might be helpful to create backups on another disk, for example, 
or to build proxy versions for use while the original is being edited.

About Resize’s File-Naming Tokens
When using the Naming option in the Export window—or with Browse’s Rename File function (page 
30)—Resize includes a broad set of tokens that you can use as part of the strings to build complex file 

All presets include an informational view that lists 
the export file type, the destination folder, and 
resize information. If you don’t wish to see that, 
click the Hide button to collapse the view to just 
the preset title.
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names, in conjunction with any custom text you wish to enter. These tokens draw on image metadata, 
including filenames, dates taken, and EXIF and IPTC metadata fields, and can be used in any number of 
combinations.

To build a rename sequence using tokens, click on the Add Token button, and choose the appropriate token 
from the pop-up menu. The token will be added as a shaded item in the text field, and the Example item 
above the text field will show a sample of a renamed file using the current set of tokens and custom text. 
To change an existing token, click on the down arrow on the right of the token, which will display the full 
set of tokens. To delete a token, double-click on it and press the Delete key.

Custom text can be added anywhere in the entry field. You can click the cursor at the beginning or end 
of a token (or in-between tokens) and add spaces, dashes, underscores and any other text you wish to be 
included in each renamed file.

There are four categories of tokens, each with their own set of options: Filename, Date/Time, Sequence, 
and Metadata. A description of each is listed below.

FILENAME

The Filename tokens use information from the 
filename or the enclosing folder that the file resides 
in. There are three options, Filename, which adds the 
current filename of the file being worked on; Filename 
Number Suffix, which takes the index (shot) number 
from the original raw file, if available; and Folder Name, which grabs the name of the folder in which the 
renamed (or imported) file resides.

DATE/TIME

This submenu consists of 17 combinations of date and 
time data, as taken from the image’s metadata. There 
are prebuilt date and time combinations (20220104, for 
example, for a year-month-date token) in the list, or your 
can build your own combinations out of the subtokens 
listed in this menu. 

Year data can be presented in either 4- or 2-digit 
numbers, and Month data can be presented in month 
number, full name, or 3-letter abbreviations.

You can use a combination of tokens and custom text to rename files (in Export or Browse) to exacting 
specifications, all drawn from file information, metadata and more.
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SEQUENCE NUMBER

The Sequence Number tokens come into play when 
exporting, importing or renaming a group of image files. 
There are essentially two tokens here, Sequence and Total, 
with options for padding zeros into each item. Sequence will 
take the group of images being worked on and, starting with 
the first item in the selection, will start at 1 and increment 
by one as each image is processed. The Total token will 
always be a single number—the number of items in the group 
being processed.

The combination of Sequence and Total tokens lets you 
create strings like ‘filename_07 of 22’ as part of the new filename.

METADATA

This submenu has five items, each with its own submenu. 
All of the items create the chosen token based on the 
embedded metadata for each image being renamed, 
imported or exported. The specific text pulled from the 
Camera and IPTC tokens will be visible in the Metadata 
pane’s EXIF (for camera-specific data) and IPTC (for IPTC 
data) tabs. The Ratings and Labels tokens are taken from any 
you have applied in Resize. 

NOTE: If there is no information in the specified Metadata token, it will be 
ignored during processing.

Camera

The Camera submenu includes 21 items, all of which are 
directly taken from an image’s EXIF data. Not all cameras 
capture all of the items listed, but most of them save essential 
items like exposure information, focal length and more.

To look at the available camera information of any image, click 
the EXIF tab in Browse’s Metadata pane (page 38).
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Ratings and Labels

The three tokens in the Ratings and Labels submenu pull 
information from any rating, label and like information you’ve 
made to images in Resize.

The Rating token will add the number of stars an image is rated, 
while the Label token will add any color label information (red, 
yellow, green, blue, purple), and the Likes token will add Liked, Not Set, or Disliked to the image name.

IPTC Metadata Tokens

IPTC (International Press Telecommunications Council) is an industry-standard metadata format, and offers 
much more detailed metadata information than EXIF. It historically has been used by journalists and stock 
photographers to catalog and tag photos, as well as add copyright information, captions, and other data. 
There are nearly 30 different tokens in the IPTC metadata submenus, which are divided into Contact, 
Content, and Image. All of these fields are visible in the IPTC tab of the Metadata pane in Browse (page 
38), and can be added during the import process as well. 

Using IPTC information makes the most sense when you have a strict method for importing and 
categorizing image data during import (or shortly thereafter).
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Printing
ON1 Resize 2022 has a flexible print engine that can print photos at any size. You can print photos 
individually; multiple photos package style, on a single piece of paper; and contact sheets for evaluating 
images. You can print from any module, even when using Resize as a plug-in. 

The print window can be opened by clicking on the Print icon in the module selector, or by selecting the 
Print command from the File menu. It has the following components:

A. Preview: Displays the photo or photos being printed.

B. View Selector: Lets you view the photos being printed individually, in facing-page view, or in 
grid view. The icon on the far right turns soft proofing on and off.

C. Filmstrip: Shows all of the photos that have been selected for printing, with check marks to 
turn printing on or off. (The Filmstrip is not visible when a single image has been selected for 
printing.)

D. Page view: Displays the number of pages being printed, and lets you move from page to page.

E. Printer pane: Contains options for output—printer or PDF—as well as printer, page setup, 
page size, number of copies, resolution, and printer profile and rendering intent.

F. Print Area pane: Contains options for fitting and selecting the print image size.

G. Watermark pane: For adding a watermark to printed photos.

H. Sharpening: Options for sharpening during the print process.

I. Print/Cancel: Print One (current image), Print All, or Cancel.
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The four panes in the Print window—Printer, Print Area, Watermark, and Sharpening—each deal with a 
specific printing-related task.

PRINTER PANE

The Printer pane is where you set the printer-specific features 
for your output. It has two modes, which are chosen by clicking 
on the icon at the top of the pane: Print, which lets you print to a 
connected printer, and File, which will print the selection to a PDF. 

When choosing to output to a printer, you’ll set the specifics of 
your printer, the paper size you wish to print to, the resolution, 
orientation, and the number of copies. When choosing resolution, 
make sure that you are printing at the printer’s optimal resolution. 
Most photo printers, for example, work best with a file that has 
between 240 and 360 ppi. (Resize will use its internal resampling 
engine to ensure that your photo is at the print resolution you 
choose.)

At the bottom of the pane is a section for choosing a printer-specific color profile; choose the media profile 
for the paper type you are printing to. 

The rendering intent is related to the conversion of an image’s colors to fit within the color range (or gamut) 
of the printer. The default intent, Perceptual, will change all of the colors in a photo proportionally to fit 
within the printer’s range of colors. The other option, Relative Colorimetric will only change the colors out 
of the printer’s gamut, to the closest in-gamut color. Depending upon the image, you might need to play 
with the intent settings, but Perceptual is usually the best place to start. (You can use Resize’s Soft Proofing 
feature to look at out-of-gamut colors in your photos. See “Soft Proofing in Resize” on page 56 for more.)

NOTE: Resize’s Print feature will work with borderless printing options as well. 
Be sure to choose your printer’s borderless options in the page setup pop-up. 
Different printers will have specific borderless settings, so check the manual to 
see how to turn borderless printing on.

Printing to a file

In addition to sending images to a printer, you can also choose to export the current print job to a file. This 
can be helpful if you are submitting prints to an online service or to print remotely.  To use this option, click 
on the File icon at the top of the pane. Resize will ask you for a filename and a location to save the file. 
Choose a page size for the file from the Page Size pop-up, and adjust your print area settings. When you 
choose Print, Resize will create a PDF of the photo (or photos) and save it with the name and destination 
you specified earlier.

The Printer pane sets printer-specific options for 
the current print job. You can also choose to render 
the print job to a PDF file.
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PRINT AREA PANE

The Print Area pane is where you set the options for the size of the 
print, and how you wish your photos to be printed. You can also 
choose whether to print photos individually, package-style, or to 
create a contact sheet for evaluative purposes. 

The top of the pane includes preset styles for either fitting the 
current photo inside the print size, or filling the entire print size;  
options for printing at common print sizes, including 8x10, 5x7, 
4x6; and options for printing to a contact sheet. You can also 
create custom print sizes via the Custom section at the bottom 
of the pane; just set the width and height of the print size, and 
whether you wish to fit the image to the print size, or to fill the 
frame with it. If you would like to save this print size as a style, 
click on the More pop-up at the top of the pane, and choose Save 
as New Style from the menu. You’ll then be able to recall that style from the More pop-up whenever you 
print.

If you are printing multiple photos, Resize will attempt to put as many photos at your chosen print size 
on the paper size as defined in the Printer pane. To print only one photo per page, click that option at the 
bottom of the Print Area pane.

Page size vs. print size

It’s worth understanding the distinction between the page size and the print size. In some cases, the two 
will be identical. For example, if you wish to print on 4x6-inch photo paper, you would choose that option 
in the Printer pane’s Page Size pop-up, and then 4x6 in the Print Area’s Custom pop-up. Depending upon 
the aspect ratio of your photo, you then might need to choose Fit or Fill to get the proper crop. Fit does 
exactly what it sounds like: it will fit the entire photo within the bounds of the photo’s dimensions, which 
means that there could be some extra white space around the final print. Fill will resize the photo to fill the 
dimensions of the chosen print size, centering the image. 

In our example, a 4x6-inch print has an aspect ratio of 2:3. If the photo you are printing has that aspect 
ratio, then Fit and Fill do the exact same thing: the photo will fill the print area without any cropping.

For package printing, where you wish to generate multiple prints on a larger sheet of paper, you’ll set the 
specific size paper you are printing to in the Printer pane, and then set the appropriate print size for each 
photo in the Print Area pane.

The Print Area pane is for setting the actual print 
size of the photo or photos you are printing.
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WATERMARK PANE

The Watermark pane adds an overlay to the printed image, and is 
most often used for your logo, signature or copyright. Watermarks 
generally need a transparent background, so make sure your 
watermark file is a PNG or PSD.

The module has the following options:

• Choose: Click the Choose button to select the file you 
wish to use as your watermark. Once you’ve added a 
watermark file, it will be saved to the Logo File pop-up.

• Size: This slider controls the size of the watermark file.

• Inset: This will determine the percentage in which the 
file is inset from the edge, based on the Position (see 
below).

• Opacity: This sets the opacity of the watermark.

• Position: This grid sets the location of the watermark. 
Click on the square of the location you desire.

When working with watermarks, make sure your watermark file 
is sufficiently large for your usage. For example, if you want it to 
appear 2 inches wide on a 300-ppi image, your watermark needs to be at least 600 pixels wide. Otherwise, 
it could appear pixelated on the print.

SHARPENING PANE

In most cases, and depending upon the media type you print 
to—glossy papers often benefit from additional sharpening, for 
example—you’ll need to add an additional sharpening step when 
printing. This is an additional level of sharpening beyond anything 
you might have applied in Resize.

The Sharpening pane lets you select a type of sharpening that will 
be applied to your photos during the printing process. The pop-up 
menu has a set of options for general sharpening, including ones 
for a standard print, glossy papers, details, high-pass sharpening, 
and many more. Depending upon the image, you might need 
to play with the settings here; performing test prints on small 
sections of a photo can often be quite helpful in determining the proper level of sharpening in a print.

BASIC PRINTING WITH RESIZE

Printing is available throughout the ON1 Resize 2022 interface. If you are viewing a photo in either the Edit 
or Resize modules, or if you have an image selected in Browse’s Grid or Detail views, clicking the Print icon 
will open the Print window with that image. There, you can set any of the options in the four panes on the 
right, and click the Print button to output your photo. 

Use the Sharpening pane to add additional 
sharpening to your printed image.
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If you wish to get an on-screen proof of the final image before you print, using the chosen color profile for 
the media type you are using, click the soft proofing icon underneath the preview area.

PRINTING MULTIPLE PHOTOS

To print multiple photos—as a package or contact sheet —select the images you wish to print from the Grid 
or Filmstrip views (in Browse or Edit), and click the Print icon. The photos you’ve selected will be displayed 
in the filmstrip at the bottom of the window, and the preview area will display the current page (at the 
printer’s page size) and print size settings. If you are printing a lot of photos at one time, you can flip from 
page to page via the Page View buttons under the preview. To see more pages,  click on the Facing Pages or 
Show All Pages icons at the bottom left of the window.

If you decide that you don’t want to print a photo, click the checkmark for that photo in the filmstrip. To 
print all of the photos currently selected, click Print. If you would like to try a test print, with a single page, 
click on the Print One button, which will print the currently selected page, as found in the Page View listing.

The Print feature gives you extensive options for printing multiple pages package style. Here, we have selected 24 photos to 
print at 5x7 inches on a letter-size sheet, on an Epson P600 printer. Clicking on the View All Pages button underneath the 
preview window, you can see all of the photos to be printed. Clicking Print One will print the currently selected page; clicking 
Print All will print the collection. 
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PRINTING CONTACT SHEETS

When you wish to evaluate a group of images but don’t want to waste larger sheets of photo paper, use the 
Contact Sheet feature in the Print window. Select the photos you wish to print, set the paper size in the 
Printer pane, and click on the Contact icon in the Print Area pane.

When you switch from Package to Contact mode, you have two options, as found in the Custom section of 
the Print Area pane:

• Columns: lets you set the number of columns across the page width. The smaller the number 
of columns, the larger the individual cells.

• Captions: Currently, Resize lets you add the filename as a caption underneath the printed 
photo. Click the button to the left of the label to turn this on or off. (We will be adding 
additional caption options in future releases.)

You can use the Page View controls underneath the preview area to move between pages, and, when 
you’re ready to print, click the Print All button to print the contact sheets.

The Contact Sheet option lets you evaluate a large group of photos in a high quality print, with captions.
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Sharing to SmugMug
If you are a member of the SmugMug photo sharing and hosting service, ON1 Resize 2022 
offers an easy to use mechanism for posting one or multiple photos to the service. This is 
accessed via the Share menu, which is found in Browse in the lower right section of the Module 
selector. On Windows, the Sharing button’s pop-up contains only the SmugMug option; on 

MacOS, there are additional sharing options beyond SmugMug (see page 78 for more information on 
these options). 

You can share a the currently selected photo or a group 
of photos by choosing SmugMug from the Sharing pop-up 
menu. The first time you access the service, you’ll receive 
an authorization window inside Resize; fill out your account 
information and password, and then click on the Authorize 
button. 

Once authorized, you’ll be presented with a window that lets 
you upload your photo or photos. The window contains a 
handful of options:

• Click the “Use photo metadata” control to include 
the photos’ metadata for use in the title, caption and 
keyword.

• The Gallery pop-up lets you add the photos to an 
existing gallery, or lets you create a new gallery. 

• The Open Gallery link to the left of the pop-up will 
open the currently selected gallery in your default 
web browser.

• The Size pop-up has three options, full-size, and 
either 4000 or 2000 pixels (on the long side).

Once you have selected the appropriate options, click the 
Share button. Resize will create high-quality JPEGs of the 
chosen photos and publish them to SmugMug.

More information about SmugMug can be found at smugmug.
com.

The first time you share to SmugMug, you’ll be asked to 
log in to your account, and verify that you want to let 
Browse post to your galleries on the site.

When you post to SmugMug from Browse, you can 
include metadata, choose the gallery to you want the 
photos to go into, and the size of the uploaded photos.
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Other Sharing Options (MacOS Only)
In addition to SmugMug publishing, the MacOS version of ON1 Resize 2022 includes other 
photo-sharing options, including:

• Mail: Creates a new email message in Apple Mail with the shared 
photo.

• AirDrop: Uses Apple’s AirDrop networking feature to share with 
local MacOS or iOS devices. 

• Notes: Adds the shared photo to Apple’s Notes app. You can 
choose to create a new note, or add the photo to an existing note.

• Messages: Shares photo to Apple’s Messages app.

• Add to Photos: Adds the photo to Apple’s Photos app.

• SmugMug: Post photos to the SmugMug service (see page 77 for 
details).

All of the sharing options perform the same operation: Resize exports a full-size JPEG of the selected photo 
and shares it with the selected target from the list. 
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BROWSE MENUS
ON1 Resize (MacOS Only)

• About ON1 Resize 2022: Opens the about box, displays your 
version number. (This is in the Help menu on Windows)

• Preferences: Opens the preferences dialog. (This item is in the 
Edit menu on Windows.)

• Quit ON1 Resize 2022: Quits ON1 Resize.

File Menu
• Browse Folder: Opens the browse dialog where you can 

select which folder you would like to browse.

• Browse Home: Navigates to your home Pictures folder.

• Browse Desktop: Navigates to your desktop.

• Add Cataloged Folder: Lets you choose a folder to add to the 
Cataloged Folders section of the Folders pane.

• Copy to My Catalogs: Copy or move a group of selected 
photos to a specific cataloged folder.

• Remove Cataloged Folder: Removes the selected folder from 
the Cataloged Folders pane.

• Manage Extras: Opens the Extras Manager for importing and 
exporting Resize presets.

• Quick Export: Saves the current image in Photoshop, TIFF, 
JPEG or PNG format.

• Resize Single Image: Opens the selected file in Resize’s Single 
Image mode.

• Send to (list): Sends your image to the selected application in 
the list.

• Group RAW Plus JPG: Stacks RAW and JPG pairs together, 
reducing clutter.

• Export: Opens the Export window.

• Export with Preset: Exports the current selection using a 
preset from the hierarchical menu, bypassing the Export 
window.

• Export with Previous: Exports the current image with the last-
used Export setting.

• Print: Opens up the print window.

• Restore Data: Starts the process of restoring from a backup.

• Back Up Data: Backs up your current Resize configuration (see 
“Backing up Your Work in Resize” on page 92).
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Edit Menu
• Undo: Removes the last file operation.

• Redo: Redoes the undo operation. This is only available if the 
last thing you did was an undo.

• Select All: Selects all the images in the current folder.

• Select None: Deselects all the images in the current folder.

• Deselect: Deselects the current item.

• Copy: Copies the currently selected items.

• Paste: Pastes the items in the clipboard to the current 
location.

• Duplicate: Makes a physical copy of the selected file, in the 
same location as the original.

• Rename File: Renames the selected file or folder.

• Delete: Moves the selected files and/or folders to the trash.

• Add Subfolder: Adds a new empty subfolder inside the 
current selected folder.

• Keyboard Shortcuts: Lets you add or modify the hotkeys for 
many of Resize’s commands.

Album Menu
• Create Album: Creates a new Album.

• Rename Album: Renames selected Album.

• Delete Album: Deletes selected Album.

• Add to Album: Add selected photos to available Albums.

• Remove from Album: Removes selected photo(s) from Album.
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Photo Menu
• Rating: Sets star rating (0 to 5 stars)

• Color: Sets the color rating of a photo (None, Red, Yellow, 
Green, Red, Purple)

• Like: Sets a photo to Like, Reject or Not Set

• Auto Advance: When checked, any color, rating or like setting 
applied to a photo will save it for that photo, then move on to 
the following photo.

• Rotate 90 Degrees CW: Rotates an image clockwise by 90°

• Rotate 90 Degrees CCW: Rotates an image counterclockwise 
by 90°

• Edit Capture Date: Let’s you adjust the date captured 
metadata, including a setting to take account for time zone 
changes.

• Set Location from GPS Coordinates: Looks up the place name 
information from the stored GPS coordinates and embeds it in 
the appropriate IPTC metadata fields.

• Embed Metadata: Stores adjusted metadata to the selected 
photo. (Only applicable to certain file formats.)

• Read Metadata from Photo: Reads the embedded metadata 
from a raw file, overwriting any data that might be in the XMP 
sidecar files. (Useful for times when the metadata appears out 
of sync with different apps.)

• Save Metadata Preset: Lets you save some or all of the 
current image’s metadata fields as a preset.

• Delete Metadata Preset: Lets you delete a saved metadata 
preset.

• Refresh Preview: Rebuilds the preview of the selected images. 
(Helpful if there are issues that are causing an image to display 
incorrectly.)
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 View Menu
• Bigger Thumbnails: Increases the size of the thumbnails in 

Grid view.

• Smaller Thumbnails: Decreases the size of thumbnails.

• Zoom In: Zooms into your image in Detail, Filmstrip or 
Compare view, displaying more detail.

• Zoom Out: Zooms out, fitting more of your image in the 
window.

• Fit to Screen: Resizes your image on-screen, to fit it entirely in 
the preview window.

• Actual Pixels: Zooms in to the 100% view of your image.

• Square Thumbnails: Changes your thumbs to square.

• Always Show Filename: Keeps the filename label turned on in 
the thumbnails while in Grid view.

• Enable Advanced Search: Enables/Disables the Advanced 
Search pane.

• Search Text: Places the cursor in the Advanced Search text 
box.

• Search by Label: Filters images by color.

• Search by Rating: Filters images by star rating.

• Search by Likes: Filters images by likes/dislikes.

• Reset Advanced Search: Resets any filters in the Advanced 
Search pane.

• Sort: Sort by filename, date, rating, label and more.

• Sort Subfolders at the Top: When sorting, puts subfolders at 
the top of the grid.

• Show Clipping: Displays the clipping overlay view, displaying 
the pure white or black pixels in the current image. 

• Show Focus Mask: Displays a green overlay on those portions 
of the current image that are in focus.

• View Mode: Select from Thumbnail (grid), Photo (detail), 
Filmstrip or Compare views.

• Preview Background Color: Change the preview background 
color.
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Window Menu
• Minimize: Minimizes ON1 Resize 2022.

• Zoom: Zooms your window.

• Full Screen Mode: Enters or exits full-screen mode.

• Full Screen Preview: Displays the current photo full-screen, 
without any additional interface elements.

• Quick Slideshow: Displays the current group of photos in a 
slideshow, with customizable time and transition effects.

• Folders: Opens and hides the Folders pane.

• Albums: Opens and hides the Album pane.

• Advanced Search: Opens/hides the Advanced Search pane.

• Recent: Opens and hides the Recent pane.

• Info/Navigator: Open and hides the Info pane.

• Metadata: Open and hides the Metadata pane.

• Keyword List: Opens and hides the Keyword List pane.

• Show Bumper Labels: Hides/reveals the text labels in the 
module selector.

• Show Browser Panel: Hides/reveals the left-side Browse 
Panel.

• Show Photo Panel: Hides/reveals the right-side Photo Panel.

• Hide Panels: Hides/reveals both left and right panels.

Help
• Search: Searches the menu options (MacOS only).

• Learning Hub: Opens the Learning Hub inside Resize.

• ON1 Resize 2022 Online Help: Opens ON1.com support page 
in your default web browser.

• Video Tutorials: ON1.com product training in your browser.

• Getting Started: Opens the initial Resize startup screens.

• Check for Updates: Checks the ON1 update server to see 
if you are running the current version; it notifies you about 
updates and will walk you through the update process.

• Sign-In/Sign-Out: Uses your ON1 account login information 
to authenticate your copy of ON1 Resize 2022.

• Provide Feedback: Opens the default web browser and goes 
to the feedback page of the ON1 website.

• About ON1 Resize 2022 (Windows Only): Opens the about 
box with the version number displayed.

• Help Improve ON1 Products: Opens the Improve ON1 
Products dialog.

• Show ON1 Log: Diagnostic tool that can help ON1 support 
when you’re having issues with ON1 Resize 2022.
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RESIZE MENUS
ON1 Resize (MacOS Only)

• About ON1 Resize 2022: Opens the about box, displays your 
version number. (This is in the Help menu on Windows)

• Preferences: Opens the preferences dialog. (This item is in the 
Edit menu on Windows.)

• Quit ON1 Resize 2022: Quits ON1 Resize.

File Menu
• Done: Saves the current image and returns to Browse (or 

external source).

• Cancel: Cancels any Resize operations and returns to Browse 
(or external source).

• Quick Export: Saves the current image in Photoshop, TIFF, 
JPEG or PNG format

• Export: Opens the Export window.

• Export with Preset: Exports the current selection using a 
preset from the hierarchical menu, bypassing the Export 
window.

• Export with Previous: Exports the current image with the last-
used Export setting.

• Print: Opens up the print dialog box.

• Manage Extras: Opens the Extras Manager window.

Edit Menu
• Undo: Removes the last file operation.

• Redo: Redoes the undo operation.

• Cut: Cuts the currently selected item.

• Copy: Copies the currently selected item.

• Paste: Pastes the items in the clipboard.

• Keyboard Shortcuts: Lets you add or modify the hotkeys for 
many of Resize’s commands.

• Preferences (Windows): Opens the Preferences dialog.
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Settings Menu
• Reset all Settings: Resets any settings made in Resize.

• Reset Resize Settings: Resets any changes made in the 
Settings pane.

• Reset Crop: Resets the crop.

• Save Settings as Preset: Saves the current Resize settings as a 
preset.

• Update Preset with Current Settings: If an image with a 
preset applied has had some settings changed, this lets you 
update the preset to reflect those new settings.

• Rename Preset: Renames the current preset.

• Delete Preset: Deletes the currently selected preset.

• Export Preset: Exports the current preset as an .onresize file.

• Import Preset: Imports ON1 Resize preset files.

• Get More Presets: Opens ON1’s Presets page in your web 
browser.

View Menu
• Zoom In: Zooms the preview window in one increment. This 

will make the preview image larger.

• Zoom Out: Zooms the preview window out one increment. 
This will make the preview images smaller.

• Fit to Screen: This sets the preview image so that the entire 
image is on screen at once. Think of this as an overview of the 
entire image. This is the setting you will use most of the time.

• Actual Pixels: This sets the preview image so that it zooms to 
actual pixels or 1:1 also called 100%. This setting allows you 
to see every pixel in the image. This is useful when making 
precision adjustments.

• Show Clipping: Shows the clipping overlay view, displaying the 
pure white or black pixels in the current image.

• Preview Background Color: Lets you set the background color 
options.

• Enable Soft Proofing: Turns on soft proofing.

• Gamut warning: Displays colors that the printer can’t 
reproduce with a red overlay.

• Profiles: Displays a list of installed printer and display profiles; 
selecting a profile will apply soft proofing for that profile.

• Intent: Lets you switch between perceptual or relative 
rendering intent for the current image.

• Simulate Paper and Ink: When turned on, Resize will set the 
white point and black point of the display to account for that 
of the chosen profile.
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Window
• Minimize: Minimizes your screen.

• Zoom: Zooms your window to full-size (doesn’t hide menus).

• Full Screen: Toggles full-screen mode (hides menu bar).

• Navigator/Loupe/Histogram: Hides or shows the Navigator, 
Loupe, Histogram (Levels) and Info pane.

• Pixel Dimensions: Opens or closes the Pixel Dimensions pane.

• Document Size: Opens or closes the Document Size pane.

• Settings: Opens/closes the settings pane.

• Sharpening: Opens or closes the Sharpening pane.

• Film Grain: Opens or closes the Film Grain pane.

• Tiling: Opens or closes the Tiling pane.

• Gallery Wrap: Opens or closes the Gallery Wrap pane.

• Solo Mode: When enabled, this feature keeps only one 
control pane open at a time.

• Open Quick View Browser: [unused]

• Show Browser Panel: Hides/shows the left Browser panel.

• Show Control Panel: Hides/shows the right Control panel.

• Hide Panels: Hides or shows all Panels.

• Document Name: Shows the name of the open image.

Help
• Search: Searches the menu options (MacOS only).

• Learning Hub: Opens the Learning Hub window inside Resize.

• ON1 Resize 2022 Online Help: Opens ON1.com support page 
in your default web browser.

• Video Tutorials: Opens ON1.com product training page in 
your default web browser.

• Getting Started: Opens the initial Resize startup screens.

• Check for Updates: Checks with the ON1 update server to 
see if you are running the current version. 

• Sign-In/Sign-Out: Uses your ON1 account login information 
to authenticate your copy of ON1 Resize 2022.

• Provide Feedback: Opens the default web browser and goes 
to the feedback page of the ON1 website.

• About ON1 Resize (Windows Only): Opens the about box 
with the version number displayed.

• Help Improve ON1 Products: Opens the Improve ON1 
Products dialog.

• Show ON1 Log: Diagnostic tool that can help ON1 support 
when you’re having issues with ON1 Resize 2022.
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PREFERENCES
ON1 Resize 2022 has a number of system-wide settings that you can set via the Preferences window. To 
access Preferences, either click on the gear icon at the lower left side of the screen, or choose Preferences 
from the ON1 Resize 2022 menu (MacOS) or the Edit menu in Windows.

The Preferences window has five tabs: General, Files, Plug-Ins, System, Services. The settings in each tab 
are described below.

GENERAL SETTINGS

The General settings tab adjusts basic settings 
for the Resize workspace, including background 
color, scrolling controls and more.

Scrolling Controls

Lets you select how the mouse scroll wheel or 
scrolling gesture works. The options are:

• None: Default.

• Preview Zoom: Adjusts the zoom of the 
preview window. Scrolling up increases the 
zoom, scrolling down decreases the zoom.

• Preview Pan: Pans the image, like using the 
pan tool or navigator. It is important that the panning is comfortable, not too fast or slow or jerky.

• Brush Size: Adjusts the size of the current tool if relevant, such as a brush tool.

Preview Background Color

You may select the color of the background behind the preview image. The default color is black. There is 
options for black, white, light gray, dark gray and custom. The custom option has a color picker where you 
can select your own background color.

Accent Color

Lets you choose the display color for highlighted items (folders, tabs, selections) in the Resize interface.

Application Language

Lets you change the display language for ON1 Resize 2022. Auto will use your system’s default language (if 
available).

Legacy Browse Tab

Checking this will change the separate My Catalogs and Browse panels to the single Browse panel found in 
earlier versions of ON1 Resize. (See “My Catalogs and Browse Panels” on page 27.) 
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Show Folder Previews

When checked, will display a thumbnail of an image from the enclosing folder in Browse. 

Check for Update on Launch

Enabled by default, the product will communicate with ON1’s software update server when you start ON1 
Photo; if an update is available it will prompt you to download or skip.

Default Browse Location

By default, the Pictures short cut in Browse is either Pictures (Mac) or My Pictures (Windows). You can 
change that location via this setting.

FILES

The Files tab is used to determine what file type 
ON1 Resize will create when opening a file in 
Resize, or when creating copies to send to an 
external editor from within Browse.

What to Edit

There are five options in this tab:

1. File Format: Sets the file type you wish 
to create: PSD, TIFF, or JPEG. If you wish 
to use a layered workflow, you must 
choose PSD.

2. Color Space: Sets the default color 
space when opening a copy of a file; the 
list includes Adobe RGB 1998, Apple 
RGB (MacOS), sRGB, ProPhoto RGB, or 
ColorMatch RGB. (If you imported a profile for use in the General preferences, it will also be available 
here.)

3. Bit Depth: Sets the bit depth for the file when opening a copy of a file.

4. Resolution: Sets the resolution when opening a copy of a file.

5. Show these options every time: If you do not wish to use a predefined set of file characteristics for 
opening photos from Lightroom or Photoshop, click this box.

Sidecar Options

Click this box if you wish ON1 Resize 2022 to create ON1-specific ‘sidecar’ files when you are editing 
images. This is helpful if you are using the same image library with multiple computers (on an external hard 
drive, for example), and want your edits to be visible on each machine. 

Treat RAW+JPG Pairs as a Single Photo

If you shoot RAW+JPG, you can use this option to ‘stack’ both photos inside Browse. (RAW+JPG pairs are 
shown with a small icon in the lower left corner of the thumbnail.)
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Apply Lens Correction to Raw Files

With this option on, ON1 Resize will use the lens correction automatically on any raw photo when you view 
it in Detail, Filmstrip or Compare modes.

Disable Base Corrections on Raw Files

With this option on, ON1 Resize will turn off the basic file correction settings applied to all raw images. 
This can be helpful for scientific/technical photography, time-lapse, and other specialized applications.

PLUG-INS

The Plug-Ins tab is specific to using Resize as a 
plug-in for Photoshop or Lightroom, and sets up 
conditions when opening files from these apps. 

General

When checked, the “Leave ON1 Resize 2022 
Open” option will keep the app open after 
processing an image via an external editor.

Photoshop

Since Resize works on the complete composite 
image (with layers), the Photoshop option is not 
applicable.

Lightroom

This lets you choose the specific options for files opened via the Plug-In Extras menu in Lightroom:

• File Type: The file type drop-down menu determines what type of file will be created. The default is 
PSD, which maintains layers. You can also select JPG or TIFF if you prefer those formats and are not 
concerned about maintaining layers. The last option is same as source, which maintains the file type of 
the original file, except for Lightroom raw files, which are saved as PSDs.

• Color Space: Sets the working color space; Adobe RGB, sRGB or ProPhoto RGB.

• Bit Depth: Sets the file bit depth, either 8-bit or 16-bit per pixel.

• Resolution: The resolution drop-down menu determines the resolution of the file.

• Stack with Original: When enabled, the new image is stacked with the original image.

• Use Original for Single PSDs: When enabled, if you select a single PSD file, it will be edited directly, 
rather than having a copy made.

• Ask Every Time: When checked, Lightroom will present these export copy options whenever you chose 
an item from the Plug-In Extras submenu. Turning this option off will bypass the file-export window 
inside Lightroom, using the options set here.



ON1 Resize 2022 User Guide Part 5: Reference 91

SYSTEM

The System tab displays performance-
related characteristics of Resize 2022.

Memory Usage
• System Usage: Specifies the 

amount of RAM that is used by the 
application. The maximum (default 
value) is 80%.

• VRAM Usage: Specifies the amount 
of video memory (VRAM) that is used 
by the application. The maximum 
(default) is 80%.

Scratch Folder Location

This setting lets you move or reset your memory cache, which helps speed editing operations while you’re 
running Resize. This is helpful if your system drive has limited space and wish to use a faster external drive 
as a cache. This cache information is purged each time you quit the application.

Performance

The Performance section is designed to help you optimize Resize for your specific setup. The adjustments 
you can make are as follows:

• Video Card Strength balances updating the preview of the image and the movement of brushes and 
gradient tool overlays. If your brush is sticking try turning it down. If you have a high-end video card try 
turning it up for faster preview updating.

• Fast Panning reduces the preview quality (makes it less sharp) while panning the photo to improve 
performance of panning.

• Fast Preview reduces the preview quality (makes it less sharp) while painting or making other 
adjustments to improve paintbrush performance. This is off if you have a high-end video card.

• GPU Render uses the GPU (video card) to render preset thumbnails, exporting, printing, sharing and 
caching. This can greatly improve performance. It is on by default for systems that support it. It may be 
disabled on lower-end GPUs.

SERVICES

This tab controls which online storage services 
are displayed in the Sources pane in Browse: 
Dropbox, Google Drive, and Microsoft 
OneDrive. Resize will automatically add any of 
the services if finds them on your computer 
during installation, but if you add any of these 
services later, use this tab to manage them.
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BACKING UP YOUR WORK IN RESIZE
To safeguard your peace of mind in the event of computer failure—or help you get set up quickly when you 
move to a new computer—ON1 Resize 2022 includes a back-up and restore function. While this feature will 
not back up your photos, it will back up the following items related to your Resize installation:

• All preferences, references to cataloged folders and other basic settings for Resize.

• Albums created in Browse.

• Metadata changes made to images in Browse, including keywords, ratings, labels, and any data added 
via the Metadata pane. 

• All Extras, including any you have imported.

To back up your Resize system, choose Back Up Data 
from the File menu in the Browse module. The Back 
Up Data window will let you choose a location for your 
backups, and also let you set a reminder schedule (daily, 
weekly, monthly, or no reminder) for backups. When you 
click the Back Up button, Resize will create a .onbackup 
file in your chosen location, with the date and time 
embedded in the filename.

To restore your system to the latest backup, choose Restore Data from the File menu in Browse. 
(Depending upon the situation, you might need to reinstall ON1 Resize 2022 first.) The Restore Data 
window will prompt you for the location of your backups, and will choose the most recent backup to 
restore from. (If, for some reason, you would like to use an earlier backup, just move the most recent one to 
another location on your hard drive.)

Clicking Restore will pull the information from the 
backup and apply it to your Resize setup. During the 
restoration process, if Resize can’t find the proper 
folders with your photos, it will present the Missing 
Folders window, with a list of each folder that it can’t 
find. You can click the Locate button to reconnect the 
folder, or you can click the ‘X’ to the left of the folder 
name in the window to remove it from Resize’s database. 

NOTE: Resize’s back-up feature will not back up your photos; you should use 
other methods to ensure that your photos are backed up in a safe place.
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